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1. WELCOME 
 
We, all of us at Advanced Geosciences Inc. (AGI), thank you very much for purchasing our 
EarthImager 2D software. Resistivity and IP data inversion with EarthImager is easier, more fun 
and more productive than ever. We look forward to hearing your success stories through the use 
of our products. 
  
1.1 EarthImager at a Glance 
 
AGI EarthImager 2D is a Windows 32-bit platform based computer program that interprets two-
dimensional (2D) electrical resistivity and induced polarization (IP) data and produces inverted 
resistivity and IP sections that reveals the sought-after target and subsurface geology. 
EarthImager turns the complicated resistivity data inversion into a simple two-step process and it 
takes only a few clicks to get inversion results, i.e., reading a data file and running the inversion. 
EarthImager also presents a long list options for advanced users to play with. 
 
EarthImager supports all Windows true type fonts and Windows 24-bit true color. Hardware 
accelerated graphics powered by OpenGL leads to fast graphics rendering. Browsing processing 
results from one parameter to another and from one iteration to another is a pleasant experience 
with EarthImager. 
 
This is a partial list of the features of AGI EarthImager 2D software. For a complete list, please 
refer to the Version Update at the end of this manual. 
 

• Resistivity and IP data inversion. 
• ERT (electrical resistivity tomography) between two or more boreholes and surface 

electrodes. 
• Time lapse resistivity inversion for monitoring applications both on the surface and 

in the boreholes (optional). 
• Survey planner with graphical model input, virtual survey with the actual command file, 

and inverse simulation with user-specified Gaussian noises.  
• IP Survey Planner. 
• Continuous Resistivity Profiler (CRP) module that processes resistivity and IP data 

collected in a continuous manner with pulled-array, boat-towed electrode array, or 
continuous roll-along array (optional).  

• Underwater resistivity surveys with underwater electrodes on an uneven water bottom. 
• Fast topographic correction and printout of resistivity section with topographical features. 
• Finite difference and finite element forward modeling. 
• Options of boundary condition for forward modeling.  
• Three inversion algorithms: damped least squares, smooth model, and robust inversion. 
• Linear IP data inversion. 
• Gauss-Newton and quasi Newton methods. 
• User friendly Windows GUI.  
• Fast graphics powered by OpenGL with automatic refresh and scalable image. 
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• Real time scrolling through all iterations using the mouse wheel, creating “movie like” 
animation. For the laptop PCs without the mouse wheel, the Show Animation menu will 
do the same. 

• Data editing for detecting and removing erroneous data points and bad electrodes. 
• Noisy data suppression. 
• Both root mean squared (RMS) error and L2-norm statistics to monitor the inversion 

progress and convergence. 
• No software limit on number of data or number of electrodes.  
• No limit on array type or electrode location.  
• A graphical a-priori information input interface. 
• Seamless operation with AGI resistivity instruments. 
• Removable contour curves and automatic blanking. 
• Windows true type font and true 24-bit color. 
• Trackable and retrievable user settings.  
• Tool buttons and popup menus for easy access to frequently used menu items. 
• Inversion progress bar to show the inversion status. 
• Well organized and hassle-free file management. 
• Automatic file saving feature with on/off options. 
• Retrievable inversion output/log file. 
• High definition report quality plat style printout.  
• Saving images as bitmap, JPEG or Windows metafile files at three resolution levels. 
• Saving image data in XYZ format so it can be loaded into any off-shelf graphics 

software.  
• Check of computer memory status to estimate processing capability. 
• Borehole command creator for AGI Sting/SuperSting instruments. 
• Support of competitor’s data file format. 
• Data misfit scatter plot and cross-plot 
• Convergence curve 
• Reversal and horizontal shift of a profile.  
• Batch inversion of many data files. 
• A new graphics toolbar for ease of access of graphics settings. 
• Options of meters and feet for the length (or distance) unit. 
• User-specified minimum and maximum variable values of the image. 
• User-specified contour line color and width. 
• User-specified contour levels and fill colors. 
• Support of Surfer® (Golden Software Inc) level files. 
• Data misfit histogram for removal of poorly-fit data at the end of inversion. 
• Output of a Surfer-format blanking file. 
• Display of elevation instead of depth for inversion with terrain. 
• Support of AGI STG data file format and DAT file format. 
• Reciprocal data error scatter plot and use of reciprocal data errors as data weights. 
• Internet-browser-type Forward and Backward buttons for review of previously-viewed 

images. 
• Academic licensing for multiple users with a single dongle. 
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• Survey Planner for borehole electrical resistivity tomography (ERT). 
• Support of null arrays (MBN or MAN). 

 
It is strongly recommended to place the infinity electrodes on the extension of a survey line. 
 
We will support any resistivity/IP data format in addition to AGI’s STG files if a sample data file 
is available. 
 
 
1.2 Where to Get Help 
 
This instruction manual is the ultimate resource for everything about EarthImager. This manual 
may be found in the installation folder and program folder of EarthImager2D as an Adobe 
Acrobat PDF file. AGI’s website will have the latest updates about EarthImager and free 
downloads with improvements and bug fixes. You are encouraged to go through the suggested 
readings at the end of this manual for in-depth understanding of resistivity and IP imaging 
methods and resistivity and IP data inversion. 
 
This version of EarthImager will read AGI’s STG data files and AGI Universal Resistivity (data) 
Files (URF). If you have any other popular resistivity and/or IP data files, please send us a 
sample data file. We will let EarthImager support your data format.  
 
EarthImager clients will have access to EarthImager User Group online. Download links to the 
latest version of EarthImager and document are available in the User Group. To enter the User 
Group, go the AGI website at HTUhttps://www.agiusa.com/UTH and choose EarthImager User Group 
under the File Areas, or go to the page 
HTUhttps://www.agiusa.com/files/eicust/earthimageruser.shtmlUTH directly. You will be asked to type in 
your user name and password that are given to you at the time you purchased EarthImager. If 
you do not have it, please contact us. From EarthImager, you may choose the menu item Help | 
EarthImager User Group to enter the User Group. Your user name and password should be 
shown as follows. If your EarthImager is over six months old, this is an indication that you have 
missed many new features. 
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For further questions, you may contact our tech support team by phone or email listed below. 
 
 
UTech Support 
 
Email: softwaresupport@agiusa.com 
Phone: +1 512 335-3338 ext. 1013 
AGI directory is listed here https://www.agiusa.com/directory.shtml. 
 
 
Snail mail: 
Advanced Geosciences, Inc. 
2121 Geoscience Drive 
Austin, Texas 78726 
U. S. A. 
Website: HTUhttps://www.agiusa.com/UTH 
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2. INSTALLATION 

 
2.1 System Requirements 
 
EarthImager will run on IBM PC and compatible models on any 32-bit Windows operating 
system that include Windows 2000/XP. The performance of EarthImager on the Windows 98 
platform is not stable due to its poor OpenGL support. As for the computer physical memory 
(RAM) requirement, one must distinguish between total physical memory and available physical 
memory. A computer running Windows XP with only 128 MB RAM can barely run any 
application program because the operating system uses up almost all 128 MB RAM. A data set 
with 28 electrodes requires less than 16MB available RAM. The more available RAM a 
computer has, the more measurements and electrodes it can deal with. Our new “Continuous 
Resistivity Profiler” module in EarthImager lifts the limit on the number of data and electrodes 
and could process tens of thousands of data and electrodes in one data file. Here are our 
recommended minimum system requirements. 
 

• Windows 2000/XP or later  
• Intel Pentinum or up 
• 20 MB or more disk space available on the hard drive 
• 64 MB or more available (free) RAM 
• 256 colors or up 
• Graphics cards that support OpenGL-powered hardware acceleration.  

 
2.2 Installation 
 
2.2.1 Installation of EarthImager 
 
We created a Windows standard setup program for ease of installation. Insert CD with 
EarthImager setup program into the CD ROM drive and the installation wizard should popup 
automatically. One may also start the installation by double-clicking the AGIEarthImager2D-
x.x.x.xxx.exe on the CD ROM (x indicates a variable version number). Before the installation 
of EarthImager, make sure that the dongle is unplugged and NOT connected to your 
computer. Follow the onscreen instructions until the installation finishes successfully. Read the 
EarthImager license agreement carefully during the installation. It is suggested that you install all 
AGI computer programs under C:\Program Files\AGI\. 
 
If the installation starts with errors and is unable to finish successfully, you may need to install 
the “dongle driver” before your installation of EarthImager. The dongle driver may be 
downloaded from the EarthImager User Group on the AGI website at  
HTUhttps://www.agiusa.com/files/eicust/earthimageruser.shtmlUTH 

 
2.2.2 Graphics card and driver  
 
We noted problems of partially black screen or corrupted images due to an out-of-date graphics 
card driver or unsupported graphics cards or inappropriate settings. If you find any problem with 
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graphics, you may 1) reduce the level of hardware acceleration, 2) update your graphics card 
driver, 3) reduce the color quality or number of colors, 4) replace your graphics card, and/or 5) 
buy a new computer. 
 
To reduce the level of hardware acceleration, follow these steps. 
 
1) Right-click the desktop and choose Properties, or go to Control Panel and click Display. Then 
click Settings tab. The screen shots below are obtained from Windows XP. 
 

     
 
2) Click the Advanced button. 
3) Click the Troubleshooting tab. Reduce the Hardware Acceleration one level at a time. If the 
graphics problem still exists while the hardware acceleration is set to None (all the way to the 
left), you have to update your graphics cards.  
 
To find out what type of graphics card your computer has, click the Adapter tab. Then you may 
go to manufacturer’s website and download the matching graphics card driver. You may, of 
course, search for the latest driver for your graphics card based on the Adapter Type using search 
engines such as google.com or yahoo.com. 
 
We noted that reducing the color quality or number of colors, for example, from 32 bit colors to 
16 bits colors, may fix the problem of image corruption. One may also try to reduce the screen 
resolution if there is any problem.  
 
If turning off the hardware acceleration, updating the graphics card diver, and reducing number 
of colors and screen resolution cannot solve your graphics problem, it is unfortunate that you 
may have to replace your graphics card.  
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2.2.3 Memory check and file association 
 
To check the memory status of your computer and find out the size of a data set in one data file 
your computer can invert, choose the menu item Check Memory under the Tools menu. Note 
that Windows XP operating system uses up to 128 MB RAM. These estimates are based on the 
surface resistivity surveys, so electrical resistivity tomography (ERT) in the borehole may have 
different memory requirement.  
 
EarthImager with the optional “Continuous Resistivity Profiler (CRP)” module could process 
tens of thousands of data in a single data file with a minimal RAM requirement.  
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You may associate AGI Sting (*.STG) file with EarthImager, so every time when you double-
click an STG file, EarthImager will be launched and data pseudosection or scatter plot will be 
shown automatically. To achieve this effect on Windows XP platform, select an STG file in the 
Windows Explorer, right-click the STG file, and choose the property. Change the program with 
which the STG file is opened. You may also achieve this by choosing the Folder Options menu 
from the Windows Explorer. 
 
2.2.4 Dongle driver installation 
 
The dongle driver, i.e., Sentinel System Driver, is automatically installed onto your computer 
while installing EarthImager. If you observe any of the following error messages when you 
launch (start) EarthImager, this indicates that the dongle driver is NOT installed correctly. To fix 
the dongle driver problem, follow these steps: 
 

      
 

1) Go to the dongle vender website at http://www.safenet-inc.com/support/tech/sentinel.asp 
to download the latest version of the dongle driver: Sentinel System Driver x.xx.x – MSI 
Installer version. 

2) Install the downloaded driver. If you observe the following warning message, it should be 
safe to click “Continue Anyway” because the dongle driver is directly from the dongle 
manufacturer. 
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3) Start EarthImager again and see if the problem is fixed.  
4) If this installation does not solve the problem, you must uninstall all Sentinel-dongle 

related programs, if any, which include EarthImager 2D, EarthImager 3D, AGI Marine 
Log Manager, and other third party programs. At the end, uninstall Sentinel System 
Driver. These can be done by going to Control Panel | Add or Remove Programs. 

5) Download Sentinel System Driver Cleanup Utility version 1.x.x from the above website 
at http://www.safenet-inc.com/support/tech/sentinel.asp  Install and run this driver 
cleanup program. 

6) Reinstall EarthImager. Stop here if EarthImager runs OK.  
7) If the problem persists, install Sentinel System Driver 5.xx.x – MSI Installer version. 

 
2.2.5 Support for 64-bit Windows 
 
According to our limited tests, EarthImager would run on Windows XP 64-bit, Windows Vista 
64-bit, and Windows Server 2003 x64. For any 64-bit operating system (OS), one must install 
the Sentinel SuperPro dongle driver manually. The driver, Sentinel Protection Installer 7.x.x.exe, 
can be found on the installation CD or from AGI EarthImager User Group. It may be 
downloaded from the SafeNet website http://www.safenet-inc.com/support/tech/sentinel.asp. 
 
AGI EarthImager is a 32-bit Windows application which can not take advantage of expanded 64-
bit memory address space. EarthImager will still run in the 32-bit mode with a maximum 
memory space of 2GB. 
 
AGI offers a command line true 64-bit EarthImager 3D CL without any GUI. EarthImager 3D 
CL would run on any 64-bit Windows, access more than 2GB memory space, and carry out 
scalable parallel processing on a multi-core and/or multiprocessor PC. 
 
2.3 Software Protection with dongles or hardware keys 
 
We use Sentinel hardware keys, i.e., dongles, to protect EarthImager. Dongles are available for 
parallel printer port and USB port. Please specify the port type when ordering. 
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UWarningU: To connect both the hardware key (dongle) and the printer to the same parallel port, 
you must turn off both the computer and the printer first. Then connect the dongle and the printer 
to the parallel port. Make sure both dongle and printer are firmly connected. Finally, you may 
turn on the computer and the printer. Here is what the dongle looks like. 
 

        
 
From the menu item Help | About EarthImager 2D, you can find your dongle serial number, a 
unique number to identify your dongle. The Option Number tells what EarthImager 2D module 
you have purchased. Option 0 indicates a base version with most of EarthImager 2D features. 
Option 1 indicates Base Version + Time-Lapse Inversion module. Option 2 indicates Base 
Version + Continuous-Resistivity Profiler (CRP) module. Option 3 is a combined version of 
Option 1 and Option 2. Info Code has not been used so far. More new modules or options are 
coming in the future. 
 
2.4 EarthImager Upgrade 
 
We have different definitions for EarthImager update and upgrade. An update means changes 
from an older EarthImager version to a newer EarthImager version. AGI gives away free updates 
of EarthImager year-round. Please go to AGI EarthImager User Group 
https://www.agiusa.com/files/eicust/earthimageruser.shtml to download the latest version.  
An EarthImager upgrade means to add one or more special-purpose software modules to 
EarthImager. At present, EarthImager 2D has three modules: Time Lapse Inversion, CRP, and IP 
Survey Planner. These software modules are already built into the EarthImager but may be 
disabled by the dongle. So EarthImager upgrade is accomplished by enabling the dongle with an 
upgrade license code.  
 
In addition, one may purchase EarthImager 3D and add the EarthImager 3D license to existing 
EarthImager 2D dongle. The software download is free from EarthImager User Group. After 
purchase of EarthImager 3D, we will email you an upgrade code to activate your dongle for both 
EarthImager 2D and 3D. 
 
AGI charge an upgrade fee for adding a new module.  It is easy and convenient to upgrade your 
EarthImager. You do not need to send the dongle (hardware key) back to AGI.  Instead, AGI will 
send you a dongle upgrade code upon the receipt of your payment.  To activate the new option(s) 
you purchased, please follow these steps 
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1) Connect the dongle to your computer 
2) Start EarthImager 2D 
3) Go to the menu item Help | Upgrade 
4) Copy and paste (or type) the update code to the license code field. 
 

  
 
5) Click the OK button to complete the dongle upgrade. One of the message boxes below will 
pop up to show the success or failure of the upgrade.  
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3. GETTING STARTED WITH EarthImager 

 
3.1 First Look at EarthImager 
 
This is the Main Window of EarthImager 2D. EarthImager is based on Windows 32-bit 
platforms. Its user-friendly graphical user interface (GUI) consists of seven main menus and two 
groups of tool buttons with eleven primary tool buttons. Most of graphics are displayed in the 
blank area of the main window. 
 

 
 
Here are the functions of eleven tool buttons under the main menu. 
 

 
 

 Read a raw data file. The AGI’s STG file is a default.  

 Choose default inversion settings. 

 Open inversion Settings Window so a user can set desired settings. 

 Start inversion. 

 Stop inversion. 
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 Save any on-screen image as a bitmap file. 

 Print out any on-screen image. 

 Launch the Color and Contour Properties Window. 

 Browser-type backward button for review of previously viewed images. 

 Browser-type forward button for review of previously viewed images. 

 Open the current trial folder in Microsoft Windows Explorer. This helps locate the current 
trial folder and browse/check the files in it. 

 gives three options of the axis label format for CRP data inversion. Three options 
are linear distance, Longitude/Latitude and UTM coordinates. 

 Shows the vertical exaggeration factor as the main window resizes. When it equals to 
1.0, the section length and depth is to scale. This factor may be changed by the user. 
 
There is another graphics toolbar one may choose to show or hide. The graphics toolbar replaces 
the vertical General Graphics Settings Window. To show or hide the graphics tool bar, choose 
the Show Graphics ToolBar under the View menu.   
 

 
 
To find out the function of each button (or control), read the mouse tip when the mouse pointer is 
over the button (or control). Here is a brief introduction to the tool buttons for graphics control. 
 

 A toggle button to show or hide the contour lines. 
 

 A toggle button to show or hide the border and project information table. 
 

 A toggle button to blank or show two edges of inverted section of surface data. This control 
also prompts for a blanking aspect ratio of horizontal offset / depth. 
 

 A toggle button to show or hide text (captions and labels) in the image. 
 

 Show or hide the image title. 
 

 To set Window’s true type font for captions and labels of an on-screen image. 
 

 , # To change distance (length) unit of the image or show the electrode number on the 
horizontal axis for a surface data set. 
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  To change IP chargeability unit in display. 
 

 A toggle button to show or hide data grid points of surface data. 
 

 To set color of data grid points and electrode symbols. 
 

A toggle button to show or hide the electrodes. 
 
The first number “5” in the toolbar indicates the image of the 5P

th
P iteration. The number “16” is 

16 colors used in the image. The number “2” means that the size of data grid points is 2 pixels. 
The last number “5” indicates the size of electrode symbols is 5 pixels. 
 
The data file name and path are shown at the top of the window. A border around the graphics 
makes nice-looking printout. A table at the lower left corner presents valuable project-related 
information and makes your work trackable. 
 
The order of main menus is basically that of inversion steps.  Here are typical data processing 
procedures with EarthImager: 
 
1) Read a data file,  
2) Change inversion settings or read a settings file, 
3) Data editing statistics (optional), 
4) Run inversion, 
5) View Data Misfit Histogram to remove data with a high data misfit (optional), 
6) Run inversion again (optional), 
7) View Inverted Resistivity Section, 
8) Change image properties such as min/max contour level, vertical exaggeration factor, 
9) Print the inversion results (images), and  
10) Save the inversion results (images and ASCII output in an XYZ format).  
 
However, you do not have to go through all these steps. You can get some quick inversion 

results in only two steps. First, read a data file by clicking the first tool button . Try cave.stg 
in C:\Program Files\AGI\EarthImager2D\demo\ folder (your folder structure may be different if 
you did not use the default installation settings or you are not in the United States). Second, click 

the green tool button  to start inversion with default settings. You should see the images 
similar to the one at the beginning of this section.  
 
3.2 Initial Settings 
 
Click Settings | Initial Settings, then Initial Settings Window pops up. These initial settings 
specify what data to reject at the initial data loading, what inversion algorithm to use, the 
function of Y coordinates (depth vs. line offset), the orientation of the vertical axis, vertical 
electrode alignment, and whether to save the processing results or not. The definition of Y axis 
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and orientation of vertical axis must be set before reading the data file for them to take effect. 
Other initial settings may be set before or after reading the data file. 
 
There are two major STG file types. The new 3D STG file format uses three coordinates (x, y, z) 
to describe an electrode location. A mandatory flag “Type: 3D” is added to the end of the first 
header line of an STG file. There is no confusion about the definition of Y axis in the 3D file 
format. The old AGI STG file uses two coordinates to identify the electrode locations. The first 
coordinate (X) is the horizontal distance, and the second one (Y) can be either the depth or the 
horizontal line offset for multiple-line pseudo-3D surface survey. You must tell the EarthImager 
what is your definition of Y axis. The Y coordinate is the depth by default. If Y is the depth, is it 
positive up or down? For a DAT data file, the vertical coordinates are positive depth by default. 
Therefore, positive upward or positive downward has no effect on the data. EarthImager would 
not work properly if negative depths are used in the DAT data file. 
 
There are seven criteria for removal of noisy data on the Initial Settings window. Any data 
beyond these thresholds will be flagged as noisy data. You may also manually delete noisy data 
by using mouse clicks and the Delete key. For surface data, the flagged noisy data will be shown 
in black dots. But for borehole data, the flagged noisy data will disappear. These flagged noisy 
data are not really removed before starting the inversion. If you change any criterion for noisy 
data removal from the Initial Settings Window, all manual data edits and electrode 
removal will be lost. Therefore, you have to redo these edits. 
 
A new threshold, Min Correlation Coefficient, was added for noisy IP data removal. A perfect 
monotonic exponential delay of IP signal would have a correlation coefficient of -1.0. This 
setting compares the absolute value of the correlation coefficient because negative IP data are 
common and have a positive correlation coefficient. An erratic pattern-less IP data along the six 
integration windows would have a very small correlation coefficient, say less than 0.3. 
EarthImager removes both IP AND resistivity data when the correlation coefficient is smaller 
than the Min Correlation Coefficient. 
 
A singular surface data point, defined as a single low or high apparent resistivity value at a 
certain depth level of the pseudo-section, will be removed by default.  
 
When the user clicks the Start Inversion button, a clean data set is saved in the current trial folder 
and is reloaded back for inversion. One may notice some changes in the data pseudosection or 
data scatter plot after choosing the Start Inversion menu item or the Start Inversion button. 
 
Inversion with the EarthImager produces many new files. It is important to keep track of 
inversion results in an organized way. EarthImager creates processing and trial directories and 
saves inversion outputs automatically. We found that this automatic file-saving feature may fill 
up your hard drive quickly if you keep running the inversion for days or weeks. If you do not 
want to save anything, you should uncheck “Save Output”. 
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3.3 Read a Data File 
 
There are two ways to load a data file. You may either choose the Read Data menu item from the 

File menu or click the first tool button . Tool buttons are used for quick and easy access to 
some frequently-used menu items. You will be prompted to choose a data file to process.  
Two coordinates are used to define electrode locations. The first coordinates X is the relative 
location of an electrode along the survey line. The second coordinate Y (or Z) is used in 
EarthImager to define the depth of an electrode for cross borehole resistivity tomography. 
Sometimes people use the second coordinate to indicate the offset of an infinity electrode to the 
survey line. EarthImager will treat this kind of data set as a borehole data set. To solve this 
problem, a dialog box will pop up and ask for your interaction. You should tell EarthImager if 
the suspected electrode is an infinity electrode. 
 
In addition to AGI Sting and SuperSting data files (*.stg), EarthImager can also read popular 
DAT files, URF files, some IPR-12 files and some GDP-32 TDIP data files. We will customize 
our program to support any ASCII data format from AGI customers. If you are interested in our 
program to process your non-STG data, please send us a sample data file. To find out if 
EarthImager supports your data format, select Read Data, and check the Files of Type box at the 
bottom of Open File dialog. 
 
We created a Universal Resistivity (data) File (URF) format to facilitate processing of resistivity 
data collected with non-AGI instruments. Here is a sample URF file. 
 
---------------------------------------- 
A 2D sample Universal Resistivity data File (URF)  
Top two lines are comments and the third line defines the length unit. 
Unit: meters 
;This file is used for illustration of URF file format only. 
;Any line starting with a semicolon (;) is a comment line 
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;A line starting with a colon (:) defines a section header.  
;A section header is required and must be spelled correctly. 
;A blank line will be ignored 
;Data entries are comma-separated. 
;Electrode locations are defined with XYZ coordinates. 
;Z = 0 on the surface and negative downwards 
 
:Geometry 
;ID, X, Y, Z 
1, 0.00, 0.00, -18.90 
2, 0.00, 0.00, -18.10 
3, 0.00, 0.00, -17.30 
4, 0.00, 0.00, -16.50 
5, 0.00, 0.00, -15.70 
6, 0.00, 0.00, -14.90 
7, 0.00, 0.00, -14.10 
8, 0.00, 0.00, -13.30 
9, 0.00, 0.00, -12.50 
10, 0.00, 0.00, -11.70 
11, 0.00, 0.00, -10.90 
12, 0.00, 0.00, -10.10 
13, 0.00, 0.00, -9.30 
… … 
 
:Measurements 
;A, B, M, N, V/I(ohm), I(mA), Error(%), Chargeability(mV/V) 
1, 5, 8, 12, -0.000025545 
2, 6, 9, 13, -0.000025567 
… … 
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To read a non-STG data file, go to File | Read Data menu or click the Read-Data tool button . 
Then choose “Universal Resistivity Files” from the “Files of Type” box (see below). You may 
find other resistivity data file formats supported in EarthImager 2D.  
 

    
 
After reading data successfully, EarthImager will display either an apparent resistivity 
pseudosection for surface survey or an apparent resistivity scatter plot for borehole Electrical 
Resistivity Tomography (ERT) data. 
 
For apparent resistivity pseudosections, the color scale is logarithmic. There is a vertical 
exaggeration of the depth scale. You can change the text font, number of colors, and figure title. 
The grid dots showing the plotting location of measurements may be turned on and off, and the 
grid dot size and color are changeable. The larger black squares on the surface show the 
electrode locations and are also editable. 
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Note that the black squares in the ERT scatter plot represent negative apparent resistivity. To 
create ERT scatter plot, all transmitting electrode pairs are sorted and numbered in an ascending 
order. For example, an electrode pair (1, 2) may have electrode ID = 1, and an electrode pair (2, 
3) will have electrode ID = 2. The same sorting and numbering is done on the receiving electrode 
pairs. All measurements on a horizontal line should have the identical transmitter. All 
measurements on a vertical line should have the same receiver.  

 
After loading the data file, you may check data editing statistics by choosing the menu item Edit | 
Editing Statistics. 
 

 
 

The number of data flagged for removal is counted based on the Criteria for Data Removal in the 
Initial Settings Window. Any edits from the Electrode Editor or manual editing will be added to 
this number. But any change in the Criteria for Data Removal will reset this number. 
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Reciprocal measurements are averaged and a reciprocal error is calculated. The duplicate 
measurements are averaged and a repeat measurement error is estimated. The new repeat 
measurement error is combined with the error in the raw STG data file by choosing whichever is 
larger. 
 
3.4 File Management and File Extension 
 
A resistivity survey project has a project name such as Cave Detection. The project name may be 
used as the top-level folder name for data processing. All data files for this project should be 
stored in this project folder. Each data file would correspond to a profile or a survey line. Under 
the project folder, a subfolder will be created for each profile automatically when you open a 
data file. This subfolder will be named after the data file name without extension. StingCave1, 
for example, will be the subfolder name for data file StingCave1.stg. For every inversion trial, a 
trial subfolder is created automatically under the profile folder with a folder name of “trial” plus 
a trial sequential number. The folder hierarchy will look like the figure below. 
 

 
 
In a trial folder, these files are saved with the default names. 
 

 
 
The INI file is the inversion settings file and may be read back into the EarthImager for inversion 
of other data sets. The OUT file is an inversion log file containing inversion settings, raw data, 
mesh definition, inverted results of all iterations. The STG file contains the actual data used in 
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the inversion after removal of noisy data. The DAT file consists of inverted resistivity section in 
an (X, Depth, Resistivity) format. InvRes4 indicates the inverted resistivity section at the fourth 
iteration. The BMP file is the bitmap image file. 
 
3.5 Edit Data File 
 
There are three ways to identify and remove noisy data. In the first approach, some possibly bad 
electrodes would be singled out for removal. The second approach is based on the initial data 
trimming threshold on the Initial Settings window. The noisy data will be automatically removed 
based on the threshold. In last approach, a user would identify and remove noisy data manually 
with the mouse clicks and Delete key. 
 
3.5.1 Edit electrodes 
 
This electrode editor helps identify and remove bad electrodes. All data associated with the bad 
electrode will be removed. The electrode editor works for both ERT and surface data. Each 
electrode is assigned a vote calculated from user-specified criteria. The higher vote an electrode 
has, the noisier the electrode is. An electrode with a vote larger than half of the number of 
electrodes is a suspected bad electrode. A horizontal or vertical linear feature on ERT scatter plot 
is usually a sign of bad electrode. 
 
To identify possibly bad electrodes in the electrode editor,  

1) You may change any “voting” criterion by clicking the Settings button. This will lead 
you to the Initial Settings page of the Inversion Settings window.  

2) Click the second column header Number of Noisy Data to sort this column at a 
descending order so that the “noisiest” electrodes are emerged at the top of the list.  

3) Check the box in front of the electrode to be removed. Uncheck the box if you change 
your mind before clicking the Remove button. However, the electrode removal is final 
and can not be undone. If a good electrode is removed, you may reload the data file and 
start from the beginning. 

4) Click the Remove button to remove the selected electrodes. 
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The third utility to identify and remove the noisy data is a manual data editor using mouse clicks 
and the Delete key. You can edit the raw data before the inversion, and remove poorly fit data on 
the data misfit scatter plot after the inversion and start the inversion again with the “clean” data.  
 
3.5.2 Edit surface data 
 
To edit the surface data, you read the raw data first. The apparent resistivity pseudosection is 
displayed. Then, you choose Edit Surface Data from the Edit menu. You should see a scatter plot 
of apparent resistivity like this. 
 

 
 
To select a data point, you click the dot using the left mouse button. Then press the Delete key to 
delete it. The color of a noisy data point usually stands out and is easy to identify. When you 
click a data point, four electrodes associated with this measurement will be highlighted. The red 
electrode is the transmitting (current) electrode A (+) and orange one is B (-), the blue one is the 
receiving (potential) electrode M (+) and the light blue one is N (-). The selected data point will 
also be highlighted with an increased point size without change of its color.  
 
At the end of the inversion of surface data, you may remove poorly fit data from the scatter plot 
of data misfit. Choose Surface Data Misfit Scatter Plot under the Convergence and Data Misfit 
menu item from the View menu. In the example below, two data points have over 80% misfit 
though overall RMS is 14.77%. You should remove these two bad data and run the inversion 
again. 
 
Noisy data to be removed may be shown in black dots depending on the settings of the Show 
Noisy Surface Data checkbox on the Initial Settings window.  
 
A singular surface data point, defined as a single low or high apparent resistivity value at a 
certain depth level of the pseudo-section, will be removed by default.  
 
3.5.3 Edit ERT data 
 
ERT data editing is very similar to editing surface data. The difference is that there is no 
pseudosection for ERT data. When you read in an ERT data file, you get to our uniquely 
designed scatter plot immediately (refer to the Section 3.3 for detail). Then you can start to 
remove noisy data using mouse clicks and the Delete key. The data point in black has a negative 
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apparent resistivity. Negative apparent resistivities in ERT data are normal but usually hard to fit. 
You may remove all negative data by checking the box “Remove All Negative Apparent 
Resistivities in ERT Data” in Initial Settings window, or remove it one by one in this manual 
editor. 
 
After you start the inversion, the scatter plot of apparent resistivity data will be turned into the 
scatter plot of ERT data misfit. To remove poorly-fit ERT data, you do not have to switch 
images. Simply click and Delete the poorly fit data. 
 

 
 
 
3.5.4 Shift and reverse profile 
 
This is a utility tool that reads a raw data file and outputs a transformed data file with new 
electrode coordinates. It helps fix some mistakes made during the data collection or the creation 
of command file. First, a survey line starts from X = 0 if one uses a generic command file. This 
is often not the case in the field. One can use this feature to shift electrode locations horizontally 
to the desired coordinates. Second, the smallest X coordinate in the field may be either the end of 
a survey line in a field survey with multiple lines.  But the smallest X coordinate on the computer 
screen or any print out is always at the left end. To facilitate the comparison of multiple lines, a 
consistent coordinate system and axis orientation are required. This utility helps reverse the 
profile, so all profiles start from the same end. 
 
Choose Edit | Shift and Reverse Profile menu item to launch the Shift and Reverse Profile 
window. Here are the steps to transform a file to desired coordinate system. 
 

1. Input a data file name by typing or click the small browse button. Number of data and 
electrodes should appear in the bottom status bar. The minimum X coordinate of all 
electrodes in the original data file will be shown in the “First Electrode Location” field.  

2. To shift the profile, change the “First Electrode Location” to the desired minimum X 
coordinate and choose a correct distance unit. 

3. To reverse a profile, check the “Reverse Profile” box. 
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4. Click the OK button to transform the electrode coordinates. If the transform is successful, 
a File Save dialog will pop up to request for an output file name. Note that the Reverse 
operation will be carried out first if selected, and then the Shift operation. 

5. Now you can process and/or invert the new data file.  
 

 
 

 
3.5.5 Removal of poorly-fit data 
 
At the end of inversion, the user can display a data misfit histogram by choosing View | 
Convergence and Data Misfit | Data Misfit Histogram.  The horizontal axis shows the absolute 
value of the relative data misfit that is defined as the ratio the difference between the calculated 
and measured data to the measured data (apparent resistivity).  
 
In general, any data with a relative data misfit greater than 50% may be considered as a poorly fit 
data and should be removed. The user should also take the error distribution into consideration. 
In the figure below, 36% can be used as the removal threshold that is represented with a vertical 
blue line. The data with a misfit larger than the threshold will be removed after clicking the 
Remove button. 
 
To set a removal threshold, the user may any of the arrow keys (Left, Right, Up and Down). The 
Left and Down arrow keys will decrease the threshold. The status bar at the bottom shows the 
number of data to be removed, and total number of data points. 
 
To remove poorly fit data, set an appropriate misfit threshold, and click the Remove button, and 
then Start Inversion again. If the user clicks the Cancel button, the threshold selection will have 
no effect in the following inversion.  
 
To access IP data misfit histogram, choose the menu View | IP Images | IP Data Misfit 
Histogram. 
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3.5.6 Scale Distance 
 
Occasionally the electrode coordinates are not scaled appropriately due to an operational error in 
the field or during the creation of a command file. This mistake can be corrected with the Scale 
Distance tool in EarthImager. 
 
Choose the menu item Edit | Scale Distance, you will arrive this interface. 
 

 
 
Choose the data file you want to scale its electrode coordinates as the input file. A default output 
file name will be recommended. Then choose a correct scale factor. Make sure the file type is 
right. Currently EarthImager support both STG data file and CRP water depth file. Finally click 
Scale and Save button, the electrode coordinates will be scaled to correct distance and a scaled 
data file will be saved in your designated folder and file name. 
 
For a CRP water depth file, the horizontal distance is scaled only. The water depth information 
remains intact.  
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The electrode coordinates of an STG data file may be scaled by setting a Distance Scale Factor 
on the Initial Settings Window before reading the data file. By this way, the original STG file 
remains intact. 
 
3.5.7 Data editing statistics 
 
Choose the menu item Edit | Data Editing Statistics to examine the data quality based on the data 
removal thresholds set in the Initial Settings Window. Note that there are overlaps in these 
numbers because a noisy data point may have a low voltage, a high repeat error and a negative 
apparent resistivity. So the sum of all numbers will be always greater than the number of data 
flagged for removal. For non-standard arrays, the singular anomalous spikes of apparent 
resistivity data should not be removed because apparent resistivity values from different arrays 
are not comparable. Check the Section 4.1.14 for details. 
 

    
 
3.5.8 Debug surface raw data 
 
Under the menu Edit | Debug Surface Raw Data, four scatter plots (see above) are provided to 
track down the problem in the raw data collected on the ground surface. When the root mean 
squared (RMS) error of an inversion does not converge to below 5% with disabled “Suppress 
Noisy Data”, the raw data is somewhat noisy. To find out what is wrong, a user may examine 
these plots: repeat error scatter plot, injected current scatter plot, measured voltage scatter plot 
and geometric factor scatter plot. These scatter plots are drawn in the same way as the apparent 
resistivity pseudosection. Borehole data is not supported at this time. 
 
Noisy data points may be removed with the Delete key on these scatter plots. Some data points 
may be shown in black due to the “Criteria for Data Removal” on the Initial Settings page. The 
user may want to check the box “Keep All” to reveal the true color of data points. However, the 
user may remove any data point using the Delete key when “Keep All” is checked. 
 
AGI resistivity meters provide repeat measurement errors in the STG data file. The repeat errors 
are usually less than 1%. If a repeat error is greater than 3%, it is likely that the corresponding 
electrode has a poor contact to the ground. 
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A large injected current would ensure high signal strength. When the current is under 20 mA, the 
data quality becomes shaky. The image below is from a dataset collected with a pole-pole array.  
 

 
 
The measured voltage scatter plot below shows a strange low-voltage feature in the middle of the 
pseudosection. This is caused by unqualified and asymmetric infinity electrodes which are not 
placed far enough from the survey area. The scatter plot of geometric factor below shows a zone 
of high geometric factors that result in a low voltage zone. 
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The absolute values of both voltage and geometric factor are plotted because these two variables 
can be either positive or negative and these two plots are in a logarithmic scale by default. A 
solid square dot indicates a positive quantity but a colored square with a void represents a 
negative value. 
 
A new addition is a menu item Edit > Debug Surface Data > Tx-RX AppRes Scatter Plot. This is 
similar to ERT AppRes Scatter Plot and it is used to display all data points when overlapping 
data points are present because of a gradient array of mixed arrays. 
 
3.5.9 View contact resistance 
 
Contact resistance is an excellent indicator of data quality and it can also help identify bad 
electrodes. A contact resistance value of over 10,000 Ohms is a clear sign of a poorly installed 
electrode which often leads to unacceptable data quality. An acceptable contact resistance value 
is often below 5000 Ohms, ideally below 2000 Ohms. It is recommended that one does a contact 
resistance check before data acquisition. This step helps spot bad electrodes and improves 
electrode contact with the ground.  
 
AGI Sting/SuperSting resistivity meters also measure contact resistance during data collection 
and save contact resistance in a CRS file. Each command line in a command file corresponds to 
one current injection and produces a contact resistance value. The View Contact Resistance 
utility displays a CRS file in a scatter plot. 
 
The contact resistance data (CRS file) can be plotted in two different ways based on the 
definition of the horizontal axis. The vertical axis is always defined as the contact resistance 
value, but the horizontal axis can be either electrode addresses or the command line number. To 
display contact resistance data, choose the menu Edit | View Contact Resistance, and then one of 
two plot options. The plot below clearly shows the electrode 25 had problems with a contact 
resistance over 8000 Ohms. 
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3.6 Inversion Settings 
 
When you launch EarthImager, the settings you used in the last inversion will be loaded 
automatically. There are several ways to set desired settings. First, you may read a settings file 
(*.ini) either through the menu File | Read User Settings. Second, you may choose desired 

settings on the Settings Window . Third, you choose hard-coded settings from the Default 
Combo Box at the bottom of the Settings Window. There are six sets of default settings: Surface, 
Borehole, CRP Freshwater, CRP Saltwater, CRP Roll-along, and Conductive Earth. CRP stands 
for continuous resistivity profiling. 
 
There are six pages of settings for advanced users. The first page is Initial Settings that 
determines what inversion method to use. The second page contains all settings to condition 
Forward Modeling. The third page is Resistivity Inversion settings. The fourth page is IP 
Inversion settings. IP inversion was implemented but not thoroughly tested. The in-depth 
explanation of these settings is given in Section 4. Two most-recently added pages are Terrain 
and CRP Settings. 
 

 
 
 

3.7 Run Inversion 
 

One may start inversion by either clicking the green tool button  or choosing the menu 
Inversion | Start Inversion. At the bottom of the window, there are two progress bars showing the 
progress of the inversion. The first progress bar to the left shows the overall progress, and the 
second one to the right shows the progress within one iteration. 
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Four files will be created and saved automatically in the current trial folder. The INI file contains 
the settings for current inversion. STG files contain “clean” raw data used in the inversion. OUT 
files are inversion log files with inversion settings and results for all iterations. The DAT file 
contains inverted resistivity data at the iteration with minimal RMS error in XYZ format.  We 
use meters as the distance unit and ohm-m as resistivity unit. At the end of inversion, you may 
use the mouse wheel to navigate through inverted results at all iterations. 
 

 
 
 
3.8 View Graphics 
 
During the inversion, the graphics showing data misfit and inverted resistivity section will be 
updated from iteration to iteration. At the end of inversion, you may browse through inversion 
results at any iteration using the mouse wheel. From the View menu, you can switch from one 
image to another easily. The graphics settings are also under the View menu. When the mouse 
pointer moves on the inverted resistivity section, its X location, Depth and Resistivity value are 
shown on the bottom status bar of the main window. 
 
3.8.1 Graphics toolbar 
 
EarthImager gives you many options to customize your graphics. These frequently used settings 
are arranged in the toolbar under the main menu. This toolbar replaced the General Graphics 
Settings window in the early version.  
 
One may choose to show or hide this graphics toolbar. To show or hide the graphics tool bar, 
choose the Show Graphics ToolBar under the View menu or find the same menu item in the 
popup menu. 
 

 
 
To find out the function of each button (or control), read the mouse tip when the mouse pointer is 
over the button (or control). Here is a brief introduction to the tool buttons for graphics control. 
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 A toggle button to show or hide the contour lines. 
 

 
 Press this button to add a nice looking border and a table showing project information to the 

graphics. This is a toggle button. 
 

 
 

 This turns on or off an edge blanking feature for surface data. So the resulting section looks 
similar to the apparent resistivity pseudosection. Surface surveys do not have good resolution at 
two ends of the survey line, so inversion artifacts are often seen at two ends. It is preferred not to 
show these artifacts as they mislead the data interpreter. 
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 This control also prompts for a blanking aspect ratio of horizontal offset to depth. Set the 
ratio to 1.0 for a 45o blanking, which may not appear as 45o due to the vertical exaggeration. A 
blanking aspect ratio larger than 1.0 seems more appropriate. Choose a larger ratio to hide 
inversion artifacts. 
 

 A toggle button to show or hide text (captions and labels) in the image. 
 

 Enable you to change text font in the graphics. Windows true type fonts are available. 
 

 Show the Iteration Number. It enables you to view graphics at a specific iteration. 
Inversion results at all iterations are stored and saved. At the end of inversion, you may browse 
through all iterations to visualize the inversion process with a mouse wheel.  
 

  Set distance (length) unit of the image. 
 

   Switch IP chargeability unit in display. 
 

 A group of tool buttons to control the display of data grid points. 

 A toggle button to show or hide data grid points of surface data. 

 Set the grid point size in pixels. 

 Set the color of data grid points and electrode symbols. 
 

 A group of tool buttons to control the display of electrode symbols. 

A toggle button to show or hide the electrodes. 

 Set the electrode symbol size in pixels. 

 Set the color of electrode symbols. 
 
 
3.8.2 Input graphics title 
 
Choose View | Graphics Settings | General Settings. Type the desired title in the box below. 
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3.8.3 Input Project Information 
 
This option brings up an interface to change the project related information which will be place 
at the lower right corner of the image. You must check “Show Project Info to view the project 
information at the lower right corner of the screen. Please note that the text field has a fixed 
length, so you should keep your input short. To fit more characters in the table, you will have to 
reduce the font size. 
 

  
 

There are two flavors of the project information table. The default format has been used before 
the version 1.8.6. The new “Custom Project Information Table” gives the user more options to 
define his or her own project information table. Most fields except data file name and processing 
software name are editable. This would be valuable for users whose language is not English. 
 
3.8.4 Raw resistivity data 
 
This will show measured apparent resistivity pseudosection for surface survey or ERT apparent 
resistivity scatter plot. There are no well-accepted ways to plot ERT measurements. We have 
found that the scatter plot is a satisfactory approach to present ERT data. Black grid points on the 
scatter plot indicate negative apparent resistivity. 
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3.8.5 Inverted resistivity section 
 
This will show a single inverted resistivity section at a user-specified iteration for both surface 
and borehole data sets. When the mouse pointer moves on the inverted resistivity section, its X 
location, Depth and Resistivity value are shown on the bottom status bar of the main window.  
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3.8.6 Pseudo and inverted resistivity section 
 
This will show measured and calculated apparent resistivity pseudosections and inverted 
resistivity section at a user-specified iteration. No ERT counterpart of this image is available. 
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3.8.7 Convergence curve 
 
This is a submenu item under Convergence and Data Misfit and it shows an XY chart of root 
mean squared (RMS) error in percentage versus iteration number.  
 

 
 
3.8.8 Data misfit pseudosection 
 
This is a submenu item under Convergence and Data Misfit. For each data point, a relative data 
error is calculated. The relative data error is defined as the difference between calculated 
apparent resistivity and measured apparent resistivity divided by measured apparent resistivity. 
The calculated apparent resistivity may be smaller or larger than the measured apparent 
resistivity, so the relative data error may be either positive or negative. The color scale is forced 
symmetrical with 0% relative data error. This image is available for surface data only. 
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3.8.9 Data misfit crossplot 
 
This is a submenu item under Convergence and Data Misfit. A crossplot is another good way to 
show data misfit. If a calculated apparent resistivity fits corresponding measured apparent 
exactly, the data point must lie on the green line. The horizontal axis is the logarithm of 
measured apparent resistivity and the vertical axis is the logarithm of calculated or modeled 
apparent resistivity. Because the logarithm of a negative number is undefined, an absolute value 
is then used. A square of four colors at the lower right corner of the image is the legend showing 
the signs of measured and calculated apparent resistivities. For example, if both measured and 
calculated data are positive, the data point is black. If both are negative, the data point is green. 
This image is available for both surface and borehole data sets. 

 
3.8.10 Borehole data misfit scatter plot 
 
This is a submenu item under Convergence and Data Misfit. At the end of the first iteration, 
borehole or ERT (electrical resistivity tomography) data scatter plot turns into data misfit scatter 
plot. We have two options to show ERT data misfit. The first one is a misfit scatter plot, and the 
second one is misfit crossplot. 
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ERT data is usually noisier than surface data. It is known to be much more difficult to reduce 
ERT data RMS error to a few percent than to reduce surface data RMS. Therefore, it is common 
to see some data with a very large data misfit. 
 
ERT scatter plot always comes with the inverted section for convenience of post-inversion data 
editing.   
 

 
 
 
3.8.11 Model sensitivity 
 
This shows relative model sensitivity. To obtain relative model sensitivity, first, multiply 
transposed sensitivity matrix by sensitivity matrix (JP

T
PJ), and then extract its diagonals. This 

diagonal has the length of the model vector. The relative sensitivity value should be always 
greater than zero. The color scale is rounded to the second decimal place. The model blocks 
closer to electrodes have a relatively larger sensitivity. A high sensitivity often leads to high 
model resolution. The inversion process will resolve model blocks with a higher relative model 
sensitivity better. The following two figures show the sensitivity section for both surface and 
cross-borehole resistivity imaging. 
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3.8.12 Time-lapse difference image 
 
There are two submenu items under this menu item: percent difference of resistivity and percent 
difference of conductivity. The percent difference of resistivity (conductivity) is defined as the 
difference between the subsequent resistivity (conductivity) and the background resistivity 
(conductivity) divided by the background resistivity (conductivity). The goal of the time-lapse 
monitoring is to visualize the subsurface changes. The difference image reveals the subsurface 
changes without the interference of subsurface geology. For cases with increasing resistivities, 
the percent difference of resistivity image enhances anomalous resistivity increases. On the 
contrary, for cases with decreasing resistivities such as water infiltration and salt water intrusion, 
the percent different of conductivity image shows stronger anomalies and provides a better visual 
effect. 

 
3.8.13 Synthetic model 
 
This shows the mesh and model of the forward simulation or the survey planner. This is the 
interface to build a synthetic resistivity model. For further information, refer to the Survey 
Planner section. 
 
3.8.14 Synthetic model and data 
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This shows the apparent resistivity pseudosection of forward simulation with the synthetic model 
at the bottom. You may modify the model at the bottom and re-run the forward simulation or the 
survey planner from this interface. For further information, refer to the Survey Planner section. 
 
3.8.15 Survey planner results 
 
This shows the survey planner result. The survey planner is, in fact, a forward and inversion 
simulator. On the screen, you will see three images. The synthetic data from numerical 
simulation is shown at the top. The middle section is the inverted resistivity model. The synthetic 
resistivity model is shown at the bottom. You may modify the model at the bottom and re-run the 
survey planner from this interface. For further information, refer to the Survey Planner section. 
 
3.8.16 IP raw data 
 
This option shows the measured apparent chargeability data in %, which is defined as the ratio of 
the measured secondary voltage to the total voltage. 
 

 
 
3.8.17 Inverted IP section 
 
This option shows the inverted intrinsic chargeability section. The chargeability may be shown in 

either milliseconds or mV/V or percentage (%) via a tool button   . 
 
3.8.18 Pseudo and inverted IP sections 
 
This option shows the measured apparent chargeability pseudosection, calculated apparent 
chargeability pseudosection, and inverted intrinsic chargeability section. Use the mouse wheel to 
scroll through all iterations.  
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More IP images on the convergence and data misfit are available from the IP Images’ submenu 
under the View menu. 
 
3.8.19 Show animation 
 
Choose the View | Show Animation menu item to show animated inversion results from iteration 
to iteration. This feature is also available from the popup menu. 
 
3.8.20 Data misfit histogram 
 
At the end of inversion, use data misfit histogram to remove poorly fit data. See Section 3.5.5 for 
detail. 
 
3.8.21 Continuous Resistivity Profile (CRP) 
 
Continuous Resistivity Profiler (CRP) is an optional module of EarthImager. CRP makes 
processing of extremely large data sets possible and efficient. CRP inverts a large data set section 
by section and assembles a long inverted resistivity section at the end of inversion. Choose the 
menu View | Continuous Resistivity Profile (CRP) to display the final inversion results if no 
shown. The scrollbar helps navigate through the entire long section. 
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3.8.22 Reciprocal data error scatter plot 
 
When a data set consists of reciprocal measurements, one may check reciprocal data error 
distribution with this plot. To launch this plot, you read the data first, and then go to View | 
Reciprocal Data Error Scatter Plot. Note that you can remove noisy data from this plot with the 
left-mouse click and the Delete key. 
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3.9 Copy Image to Clipboard 
 
You may copy any on-screen image to the Windows clipboard by choosing Copy Image to 
Clipboard menu item from the Edit menu or from the popup menu by clicking the right mouse 
button. Then the image on the clipboard may be pasted to any Windows program such as MS 
Word, Powerpoint, Paint, and Photo Editor. This feature is different from the function of 
PrintScreen 
 

   
 

  
 

3.10 Save Image 
 
The onscreen image may be saved as a bitmap, JPEG or Windows metafile file at any of three 

resolution levels. To save an onscreen image, you may either click Save Image tool button  or 
choose Save Image menu item from File menu or Choose Save Image from the popup menu. In 
the Save as type box at the bottom, choose your desired image file type and resolution. You have 
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three graphics file types to choose from. JPEG files are small but have a low resolution. Bitmap 
files are usually over 1MB but have a high resolution. You may reduce the size of bitmap files 
using any zip or compressing utility. You have three resolution options to choose from: screen 
resolution, medium resolution and high resolution. Screen resolution is good enough for a 
general purpose use. The saved graphics will preserve the aspect ratio of the onscreen image. So 
resize the window to the desired shape before you save the graphics. The current trial folder is 
recommended. The recommended file name will look like this: cave_trial3_InvRes5.bmp. Cave 
is the prefix of the STG file name (cave.stg). The current trial is trial 3. You are saving the 
inverted resistivity section at the fifth iteration. 
 

 
 
3.11 Save Data in XYZ Format 
 
In this release, you can save the measured resistivity pseudosection,  data misfit pseudosection, 
inverted resistivity section, sensitivity section, and percent difference section of time lapse 
inversion in (X, Y, Z) format. Pick an iteration using the mouse wheel, then go to Save Data 
under the File menu. The DAT file extension is mandatory. The current trial folder is 
recommended. The recommended file name will look like this: cave_trial3_InvRes5.dat. Cave is 
the prefix of the STG file name (cave.stg). The current trial is trial 3. You are saving the inverted 
resistivity section at the fifth iteration. 

 
 

The tool button (  ) on the graphics toolbar changes the length unit from meters to feet or 
from feet to meters. The saved data in XYZ format will have the length unit of the user’s choice. 
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When saving an inverted resistivity or IP section or sensitivity section, a Surfer-format blanking 
file (*.bln) is also saved in the current trial folder. 
 
To save inverted section without two triangular edges for the surface data, choose “XYZ Data 
File Excluding Edges” from the “Save as type” box in the File Save Dialog. 
 
To save inverted section without two triangular edges in the batch mode, the user has two 
options. First, set ExcludeEdges = 1 in the inversion settings file (*.INI). This will initialize the 
“Exclude Edges” checkbox on the Batch Inversion Window. Second, the user may check or 
uncheck “Exclude Edges” checkbox to a desired setting. The setting of “Exclude Edges” 
checkbox will overwrite any setting in the INI file. 
 

 
 
3.12 Save STG Data 
 
Choose Save STG Data from the File menu and save a “clean” STG data file after automatic and 
manual noisy data removal. This “clean” file is automatically saved in the current trial folder 
when “Start Inversion” is launched. So, do not repeat this action after the inversion is done 
unless you want to save an STG file elsewhere. The saved STG data file will be in the 3D (x, y, 
z) format. 
 
This feature will be useful in these two occasions. First, one can edit a data file for the time lapse 
inversion because the time lapse inversion does not allow data editing. Second, when one reads 
in a non-STG data file, this feature may be used to convert a non-STG file into an STG file.  
 
3.13 Print Image 

To print an onscreen image, you may either click Print Image tool button  or choose Print 
Image menu item from File menu or Choose Print Image from the popup menu. For custom 
printing, choose Page Setup from File menu. You are given options for page orientation, 

 Page 51 of 140



Instruction Manual of AGI EarthImager 2D, 2014-11-24 

margins, and output resolution. High resolution is the highest DPI (dots per inch) of the printer. 
Medium resolution is one half of printer’s DPI. Low resolution is one quarter of printer’s DPI. 
The printed image will be stretched to fit the settings in Page Setup, but the orientation, aspect 
ratio, and size may differ from the onscreen image.  
 

 
 
3.14 Save Synthetic Model 
 
Go to the menu File | Save Synthetic Model to save user-created resistivity and IP models in the 
Survey Planner or Input A-Priori Model interface. There are two types of model files in 
EarthImager. An MDL file is a combined command file and synthetic model tied to the modeling 
mesh. An MDL file can be read into EarthImager for forward and inverse simulation. An MOD 
file lists a-priori resistivity and IP model blocks and it is used to constrain the inversion. An 
MOD file can be created manually in a text editor or in EarthImager. Here is a sample MOD file. 
 
;A-Priori model file (*.mod) by AGI EarthImager 2D. Version: 2.1.2 (Build 478) 
unit=meters 
  
:ResModel 
; The synthetic model is listed block by block as follows: 
; Block Resistivity (Ohm-m) 
; Xmin, Ymax, dx, dy 
  
Background Resistivity = 100 
  
1000.00 
120.000,  -7.697,  2.500,  3.095 
1000.00 
122.500,  -7.697,  2.500,  3.095 
 
:IPModel 
; The synthetic model is listed block by block as follows: 
; Block Chargeability (mV/V or ms) 
; Xmin, Ymax, dx, dy 
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Background Chargeability = 20 
  
200.00 
150.000,  -14.197,  2.500,  3.745 
200.00 
152.500,  -14.197,  2.500,  3.745 
 
Both a-priori resistivity and IP models can be listed together in one MOD file. A rectangular 
model block can be defined by block resistivity or chargeability, upper-left corner coordinate (x, 
y), and width and height of the rectangular block. There is no limit on the number of blocks. 
 
When you click Tools | Forward Simulation or Tools | Survey Planner to start a simulation, an 
MDL file and an MOD file are saved automatically in the current trial folder. You may save 
these two files elsewhere and in different names by going to this menu File | Save Synthetic 
Model. A MOD file saved this way can be read into EarthImager as a-priori model. 
 
In a regular data inversion process, a user may build a-priori model from the menu Settings | 
Input A-Priori Model after reading a raw data file. Under this mode, File | Save Synthetic Model 
will save the synthetic model as an MOD file without any MDL file. 
 
3.15 Read A-Priori Model 
 
Go to the menu File | Read A-Priori Model to input an MOD file to constrain the inversion. 
EarthImager will try to keep model blocks in the MOD file unaltered during the iterative 
inversion process. An MOD file can be created manually in a text editor or in EarthImager 
Survey Planner. Refer to the MOD file format in the last section. 
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3.16 How To Read and Invert Res2DInv Data File 
 
EarthImager 2D can read and invert Res2DInv data files. First, you read the DAT file. Then you 
may save the DAT file as the AGI STG file. This step is not necessary. Finally, you run the 
inversion as if you just read an STG file. Here are the steps to handle Res2DInv DAT files in 
detail. 
 

1. You may either choose the Read Data menu item from the File menu or click the first 

tool button . You will be prompted to choose a data file to process. 
 

    
 

2. From the Open File dialog, choose Data Files (*.dat) as the Files of type. 
3. Select the DAT file you want to read and process. 
4. Once you read the DAT file successfully without any error message. You may save the 

DAT file in the AGI STG format by choosing Save STG Data from the File menu. This 
step is not required for further processing. In fact, after you choose Start Inversion, an 
STG file will be saved in the current trial directory automatically. 

5. You are now at the stage exactly same as the end of reading an STG file. You will see the 
data pseudosection or ERT data scatter plot on your screen depending on your date type. 
You may change settings, or edit the data, or edit electrodes, or start the inversion. 
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4. INVERSION SETTINGS EXPLAINED 

 
All inversion control parameters are arranged on Settings Window. There are four pages of 
inversion settings: Initial Settings, Forward Model, Resistivity Inversion, and IP Inversion. You 
may go to desired settings page directly from Settings menu or click Inversion Settings tool 
button  to bring up Settings Window. The Default Combo Box at the bottom of Settings 
Window will reset all settings to hard-coded default settings for several typical scenarios such as 
Surface, Cross-Borehole ERT, CRP-Freshwater, and CRP-Saltwater. The User Settings option in 
the Default Combo Box corresponds to the settings of the last inversion. Other three buttons at 
the bottom follow the Windows convention. 
 
4.1 Initial Settings 
 
After reading the data file, noisy data is flagged on the basis of the Criteria for Data Removal on 
the Initial Settings Window. The manually deleted noisy data in the Electrode Editor, the Surface 
Data Editor and ERT Data Scatter Plot by the user will also be flagged for removal. Note that 
these flagged noisy data are not actually removed. When the user clicks the Start Inversion 
button, all flagged noisy data will be removed and a clean data set is saved in the current trial 
folder. One may notice some changes in the data pseudosection or data scatter plot after clicking 
the Start Inversion. 
 

 
 

4.1.1 Minimum voltage in mV.  
 
The measured voltage shows the actual signal strength. The minimum voltage should be set close 
to the hardware resolution or the environmental noise level. Any signal less than 1 mV is usually 
too small to measure accurately. In the case of borehole data, measured voltages less than 1 mV 
are common. In particular, boreholes filled with conductive materials produce weak signals. 1 
mV threshold may lead to removal of more than 50% of the data. 
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4.1.2 Minimum abs(V/I)  
 
V/I is the voltage measurement normalized by the injected current and has a unit of ohm. Any 
V/I measurement with an absolute value smaller than this setting will be removed at the data 
input. 1.0×10P

-4
P ohm is a safe setting, but a value between 2×10P

-4
P ~ 5×10P

-4
P ohm is recommended. 

Never set this parameter greater than 1×10P

-3
P. 

 
4.1.3 Maximum repeat error (%) 
 
This setting applies to AGI Sting/SuperSting resistivity systems only. The error in the repeat 
measurements is usually smaller than 1%. Set this parameter to a value between 5% ~ 10%. 
 
The repeat measurements with the AGI Sting/SuperSting are a measurement stacking process. 
Two or more stacks may be selected. The instrument records an averaged data and a repeat error.  
 
Another type of repeat measurements are generated by duplicate measurement commands in the 
command file, that is, one gets two ore more data points at the same electrode geometry. These 
duplicate measurements are redundant for the inversion and must be averaged to produce a single 
data point. At the same time, the duplicate measurement error is estimated and is assigned to the 
repeat error measure if it is larger than the original repeat error in the raw data file. 
 
4.1.4 Min apparent resistivity.  
 
This is the smallest apparent resistivity value in ohm-m allowed in the inversion. For surface 
resistivity surveys, all negative apparent resistivity values will be removed at the same time. For 
electrical resistivity tomography (ERT) data, negative apparent resistivity values are common. 
This setting will then remove any apparent resistivity value when its absolute value is smaller 
than this setting. To remove all negative apparent resistivity values in ERT data, use another 
setting in this group. 0.1 ohm-m is a safe setting, but a value between 0.1 ~ 1.0 ohm-m is 
recommended. 
 
4.1.5 Max apparent resistivity.  
 
This is the largest absolute apparent resistivity value in ohm-m allowed in the inversion. Any 
measurement with its absolute value of apparent resistivity larger than this setting will be 
removed. 1.0×10P

5
P ohm-m is a safe setting, but a value between 1×10P

4
P ~ 1×10P

5
P ohm-m is 

recommended. 
 
4.1.6 Max reciprocal error.  
 
This setting is effective only when reciprocal measurements exist. A reciprocal measurement is 
obtained by switching transmitting electrodes and receiving electrodes of the original 
measurement. That is, if the original measurement uses A, B, M, N four electrodes, the 
reciprocal measurement will have ABrB = M, BBrB = N, MBrB = A, and NBrB = B. Theoretically, the 
original and reciprocal measurements should have identical V/I. The reciprocal error is usually 
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greater than the error of repeat measurements because of electrode polarization, cultural noise, 
natural potential, and telluric currents.  
 
4.1.7 Remove all negative apparent resistivities in ERT data.  
 
This setting works only with ERT data. Negative apparent resistivity values are very common in 
ERT data and may be good measurements. If you find most of red dots off the green line in the 
ERT crossplot, you should check this box to remove all negative apparent resistivity values. 
Negative apparent resistivity values are automatically removed in the surface resistivity data. 
 
4.1.8 Inversion method 
 
You decide what inversion method to use from the initial settings page. If you choose forward 
modeling only, it will produce forward solution (calculated apparent resistivity) of starting 
resistivity model. Damped least squares inversion method is relatively fast, but the reconstructed 
resistivity model tends to be rough due to lack of roughness constraints. Robust inversion should 
have better performance over noisy data and resolve resistivity boundaries better. Smooth model 
inversion is stable and robust. We strongly recommend it for all types of data.  
 
4.1.9 Y axis 
 
The AGI STG file and command file use two coordinates to identify the electrode locations. The 
first coordinate (X) is the horizontal distance, and the second one (Y) can be either the depth or 
the horizontal line offset for multiple-line pseudo-3D surface survey. You must tell the 
EarthImager what is your definition of Y axis. If Y is the depth, is the positive up or down? 
 
The vertical axis is positive upward by default. That is, the vertical axis has positive coordinates 
above the ground surface and negative coordinates below the ground. If your vertical axis in your 
data is positive downward, you should change this setting. However, we use depth as the vertical 
axis in our graphics, so it is positive downward. 
 
4.1.10 Minimum electrode spacing 
 
There are a large number of dynamic electrodes in a continuous resistivity survey with a boat-
towed array and a pulled-array on land. Some electrode spacing can be smaller than one 
centimeter (1 cm). A large number of electrodes cause a highly-irregular mesh and slow down 
the numerical modeling dramatically. By setting a minimum electrode spacing in the horizontal 
direction (X), several closely-spaced electrodes may be “combined” into a single electrode, that 
is, several closely-spaced electrodes will be forced to have the same coordinate based on the 
threshold set here. This would result in some errors in the modeling, but speed up the inversion 
and reduce the memory usage. 
 
For best performance, corresponding electrodes in two or more boreholes should be aligned at 
the same elevation layer by layer, that is, the top electrode in borehole 2 should have the same 
elevation as that of the top electrode or any electrode in borehole 1. This would be very difficult 
during the field setup, especially when the electrode spacing is not constant. The vertical 
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electrode alignment may be accomplished by adjusting electrode geometry in the command file 
or setting the minimum electrode spacing in the vertical direction (Z). This setting is used to 
force vertically closely-spaced electrodes in the same and different boreholes to have the same 
elevation. 
 
4.1.11 Save processing output 
 
Inversion with the EarthImager produces many new files. It is important to keep track of 
inversion results in an organized way. EarthImager creates processing and trial directories and 
saves inversion outputs automatically. We found that this automatic file-saving feature may fill 
up your hard drive quickly if you keep running the inversion for days or weeks. If you do not 
want to save anything, you should uncheck “Save Processing Output”. 
 
4.1.12 Distance scale factor 
 
This scale factor helps make up an operational error occurred during data collection with AGI 
SuperSting. When a command file with one unit electrode spacing is used, one may input a scale 
factor on SuperSting to scale the electrode spacing to a desired value. SuperSting users 
sometimes accidentally input an incorrect scale factor, and this results in incorrect electrode 
coordinates in STG data files. This factor is used to scale the electrode coordinates back to their 
correct values. All electrode coordinates will be multiplied by this distance scale factor. 
 
This factor is set to 1.0 by default and it has a one-time effect only. Therefore, you have to set 
this factor to your desired value whenever you read an STG file with incorrect electrode 
coordinates or spacing. After an STG file is read into EarthImager, this factor returns to 1.0 
immediately. So one has to check and set this factor before reading an STG data file. 
 
To achieve the same goal, you may go to Edit | Scale Distance and convert and save a scaled data 
file. 
 
4.1.13 Keep all data 
 
Check this box and set the criteria for data removal to the extreme values. It is hoped that all data 
in the (STG) data file will be kept for inversion under these extreme thresholds. 
 
4.1.14 Remove Spikes 
 
Check this box to remove anomalous and singular spikes on the apparent resistivity 
pseudosection, that is, any single apparent resistivity value that stands out on a pseudo-layer will 
be removed based on the hard-coded threshold inside the program. 
 
4.1.15 Skip data 
 
This is a data decimation feature. While reading the data, EarthImager skips the specified 
number of data points in the raw data file and then reset this number to 0. For example, if this 
parameter is set to 1, EarthImager will extract every other data point in the data file for the 
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inversion. Half of the measurements will be removed (skipped). If you want to extract every fifth 
data point of the raw data file for inversion, set this number to 4 to skip 4 data points. This 
parameter is set to 0 by default to read all data without skipping any, and resets to 0 after every 
data decimation operation to avoid losing data. 
 
4.2 Forward Modeling Settings  
 
There are 11 parameters on the Forward Modeling settings page. This page gives you options to 
choose the forward modeling method, forward matrix equation solver, type of boundary 
condition, mesh discretization, and so on. 
 

 
 

4.2.1 Forward model method 
 
You may choose either the finite difference or finite element method. The finite difference 
method is fast, but the finite element method produces more accurate forward modeling solution 
with the “same” mesh discretization. Moreover, the finite element method models earth 
topography better. The finite difference method is a recommended default setting. 
 
4.2.2 Forward equation solver 
 
You may choose either Cholesky decomposition (CD) or a conjugate gradient (CG) forward 
solver. Both methods are numerically robust and stable, but the Cholesky decomposition method 
is much faster than the conjugate gradient method for typical resistivity data sets with more than 
20 electrodes. The CG method takes much less memory space, and runs faster for cases with 
fewer electrodes. The CG method was implemented for educational purpose. You should not use 
CG method without a good excuse. 
 
4.2.3 Boundary condition 
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Neumann boundary conditions (BC) are always imposed at the ground surface. Left, right and 
bottom boundaries have options of Dirichlet BC or mixed BC. Mixed BC are supposed to 
produce more accurate forward solution. According to our observation, their difference seems 
negligible. 
 
4.2.4 Number of mesh divisions 
 
This sets the minimum number of cells (blocks) between two electrodes. For cross-borehole 
electrical resistivity tomography (ERT) without surface electrodes, the number of blocks 
between two boreholes depends on the vertical spacing of electrodes. A finer mesh results in 
higher accuracy of forward modeling, but longer CPU time. This setting is a dominant factor on 
the run time of inversion. Two (2) divisions is the default setting. The number of divisions 
should be set between 2 and 8. 
 
4.2.5 Thickness incremental factor 
 
This setting applies mainly to surface resistivity surveys where model resolution degrades with 
depth. It is preferred that layer thickness increases with the depth. Thickness incremental factor 
is defined as the ratio of the thickness of the lower layer to the thickness of the layer immediately 
above it. For example, if the upper layer is 1 meter thick, the lower layer will have a thickness of 
1.1 meters if the thickness incremental factor is 1.10. It is not realistic to set this factor smaller 
than 1.0. This factor also plays a role in determining the layer thickness below the borehole’s 
bottom electrode in the borehole for a survey combining surface and borehole electrodes. 
 
Because the layer gets thicker and thicker, it is preferred to set this factor in the range of 1.0 to 
2.0. With a large factor, you lose resolution at the depth. A large thickness incremental factor 
will, to some extent, reduce the runtime of inversion.  
 
4.2.6 Depth factor 
 
This setting applies mainly to the surface resistivity survey. The depth of the inverted section is 
determined by the maximum median depth times the depth factor. Median depth is a function of 
electrode spacing and array type. In a survey with combined surface and borehole electrodes, this 
depth factor also plays a role in setting the depth of inverted section. The depth factor should be 
set between 1.0 and 1.5. 
 
4.2.7 Maximum number of CG iterations 
 
This setting is enabled only when the conjugate gradient (CG) method is chosen as the forward 
solver. The CG method is an iterative matrix equation solver. Sometimes the CG solver may 
diverge and the CG iteration becomes an infinite loop. The maximum number of iterations will 
prevent this. This setting should be greater than 100 but smaller than 1000. More iterations will 
generally lead to a more accurate forward solution, but will require a longer runtime of forward 
modeling.  
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4.2.8 CG stop residual 
 
The conjugate gradient (CG) method is an iterative solver that requires a stop criterion. If the CG 
residual is smaller than the stop residual, the CG iteration exits. 1.0×10P

-6
P or 1.0×10P

-7
P is a 

recommended setting. 
 
4.3 Resistivity Inversion Settings 
 
4.3.1 Stop Criteria 
 
Resistivity data inversion is a nonlinear iterative process. This group of parameters sets the rules 
that stop the iteration. Four factors within this group have a logical OR relation, that is, if any of 
the criteria is met, the inversion will stop. To activate or enable a rule, check the box in front of 
parameter. 
 
4.3.2 Number of iterations 
 
This sets a maximum number of iterations for an iterative nonlinear inversion stop. If the 
inversion diverges, it will stop after the prescribed maximum number of iterations. Thus infinite 
loops can be avoided. For surface resistivity surveys, inversion usually converges in 5~6 
iterations. Set this number to 8 or 10 in this case. For ERT data, it often takes more than 10 
iterations to converge. Set this number to 15 for ERT data.  
 
4.3.3 Maximum RMS error 
 
The primary objective of inversion is to reduce data misfit between field measurements and 
calculated data of a reconstructed model. Measurement errors usually range from 1% to 5%. But 
do not forget about numerical errors and rounding errors. This number should be equal to or 
larger than percentage of noise estimate. 3% is a default setting. 
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One of the objectives of the resistivity inversion is to find a resistivity model whose response 
(predicted data) best fits the measured data. The goodness of the fit may be characterized by the 
root mean squared (RMS) error in percent (%) defined below. 
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where N is the total number of measurements, dP

Pred
P is the predicted data and dP

Meas
P is the 

measured data. It is clear that the RMS error depends on the number of bad data points and how 
bad each bad data point is. 
 
Note that the RMS error is an average data misfit over all data points. A single erroneous data 
point could lead to a large RMS error. For example, we have a data set of 100 measurements 
(N=100). As an extreme case, the measured voltage is 1mV but the predicted voltage is 1V. If we 
have a perfect fit (no errors) to all other 99 data points, the RMS error would be 9990% due to 
this single erroneous data point. Therefore, the RMS error does NOT indicate the percentage of 
bad data points. 
 
In the case above, there is no way to reduce the RMS to below 10% even if one gets perfect data 
fits to the remaining 99% data. The only way to reduce the RMS error in this case is to remove 
the bad data point. In the following section, we will show that removal of some bad or good data 
points would not reduce the resolving power of the original data set significantly. 
 
To compare the RMS errors resulted from different inversion programs, one must compare the 
definition of the RMS error first because the RMS error may be defined differently. 
 
A large RMS error is the result of  
 

1) Data noise, 
2) Numerical modeling error, 
3) Inability to model 3D objects with a 2D modeling program, and 
4) Poor inversion settings. 

 
4.3.4 Error reduction 
 
It is generally expected that data misfit, e.g. RMS error, be reduced from iteration to iteration. 
The first several iterations have a larger RMS error reduction than later iterations. When RMS 
error reduction is very small or RMS error increases, the inversion should be terminated. This 
parameter sets a threshold for this purpose. It is recommended that the inversion stop when error 
reduction is smaller than 5%. Sometimes it is normal that the convergence of inversion is not 
monotonic. This error reduction factor may cause termination of the inversion prematurely. This 
is why the box in front of this setting is unchecked by default. 
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4.3.5 L2 norm 
 
L2-norm is another measure of data misfit. It is defined as the sum of the squared weighted data 
errors. N is the number of measurements. WBiB is the data weight, dP

calc
P is the calculated data, dP

meas
P 

is the measured data. The L2-norm depends on the estimate of data weights (errors). Set the 
percentage of data errors (noises) to 3% if you have no knowledge of data noises. Any inversion 
in a least squares sense, such as damped least squares and smooth model inversion in 
EarthImager, should stop when the L2-norm is smaller than the number of measurements.  
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The number of measurements (data points) varies from data set to data set. To avoid confusion, 
we define a normalized L2-Norm measure as 
 

Normalized L2-Norm = L2-Norm / (Number of Data). 
  
When the normalized L2-norm reduces to the unity (1.0) or smaller, the inversion is converged. 
Check L2-Norm box to set this measure in effect. 
 
4.3.6 Number of iterations (inner) 
 
This number should be set between 5 and 10. There are two loops in an iterative nonlinear 
inversion. First, a nonlinear inverse problem is linearized and solved step by step. This is the 
outer loop of the nonlinear inversion. The number of steps here is the number of iterations people 
are generally referred to. Second, to solve the linearized system at each step, an iterative solver is 
used. This is the inner loop. This parameter sets the number of iterations for this inner loop.  
 
4.3.7 Starting iteration of quasi Newton method 
 
We solve the nonlinear inverse problem using the Gauss-Newton method with an accurately 
calculated sensitivity matrix. This method requires recalculation of the sensitivity matrix at every 
iteration. Calculation of the sensitivity matrix takes up more than 80% of total inversion time. 
The Quasi-Newton method uses an approximate estimate of the sensitivity matrix with a 
sensitivity update scheme. This greatly speeds up the inversion, but sacrifices the model 
resolution due to inaccurate sensitivity. The starting iteration number of the quasi Newton 
method should not be smaller than 3. If the runtime is not your top priority, you should not use 
the quasi Newton method at all and instead set this parameter greater than 20.  
 
4.3.8 Smoothness factor 
 
This is a Lagrange multiplier whose effect is to balance data misfit and model constraints. Our 
suggested setting is 10 for surface data, and 100 for ERT data. If you have noisy data, a 
relatively large smoothness factor is preferred. The smoothness factor will be reduced from 
iteration to iteration. A small smoothness factor will produce a relatively rough model, and a 
large smoothness factor will produce a relative smooth model. 
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4.3.9 Damping factor 
 
We suggest you set this parameter to the same value as the above smoothness factor. This factor 
suppresses the effect of small eigenvalues of the Hessian matrix at earlier iterations and speeds 
up the convergence at the early stage of inversion. 
 
4.3.10 Percentage of noise 
 
There are three settings in the data weights group. Our inversion algorithm minimizes a weighted 
data misfit (L2-norm), but RMS error is irrelevant to data weights. 
 
Without prior knowledge of the standard deviation of the data such as reciprocal error, you may 
assume a certain percentage of error in data. This number usually ranges from 1% to 5% with a 
default of 3%. With the L2-norm stop criterion enabled, a too large noisy estimate produces a too 
smooth model. A too small noisy estimate forces the inversion to fit data noise and produce 
artifacts. 
 
4.3.11 Use reciprocal errors 
 
If reciprocal measurements are taken during the data collection, you may use reciprocal data 
errors as the data weights. However, the measurement error is just part of errors to be considered 
in the inversion process. Numerical modeling algorithms have some inherent errors due to 
discretization and round-off errors.  
 
When reading a data file, EarthImager would check for reciprocal measurements automatically. 
If EarthImager finds a reciprocal measurement, it merges the forward and reverse measurements 
by averaging, calculates a relative reciprocal error, and flags the data for removal if the 
reciprocal error is above the threshold set on the Initial Settings window. No data would be 
removed before clicking the Start Inversion button. The “For Removal” flags may change if you 
change any Criteria for Data Removal. Go to the menu View | Data Editing Statistics for noisy 
data statistics. 
 
For a data point without a corresponding reciprocal measurement, EarthImager uses the 
percentage of noise described in the last section (section 4.3.10) as the data weight. So set this 
percentage appropriately at all times. 
 
For a data point with a very small reciprocal error, say less than 1%, EarthImager sets a 
minimum error at 1% because of the numerical modeling error described above. 
 
If the User Reciprocal Errors box is unchecked, EarthImager uses estimated percentage of noise 
as the data weights. 
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4.3.12 Suppress noisy data 
 
If you have noisy data or a slow convergence, you should check this box. This scheme gives less 
weight to noisy and hard-to-fit data. This will not improve RMS convergence because RMS is 
not a weighted quantity. Instead, the L2-norm convergence should improve dramatically. 
 
By checking this box, L2-norm stop criterion will be also enabled automatically. 
 
4.3.13 Robust data conditioner 
 
This is a setting for robust inversion only. Set this parameter around 1.0. A larger data 
conditioner produces a smoother model. A smaller data conditioner produces a blockier model. 
 
4.3.14 Robust model conditioner 
 
This is a setting for robust inversion only. Set this parameter around 1.0. Unlike the robust data 
conditioner, a larger model conditioner produces a rougher model. A smaller model conditioner 
produces a smoother model. 
 
4.3.15 Starting model 
 
The user is given three options to set a starting model: interpolated pseudosection, average 
apparent resistivity and custom homogeneous starting model. The default choice for any type of 
data set is a homogeneous half space with a resistivity value equal to the average of all apparent 
resistivity values (Avg AppRes). 
 
Note that the artifacts on a pseudosection would be passed onto the inverted section. The starting 
model has a critical impact on the processing results. The interpolated pseudosection is often 
found to be a good starting model for a surface data set without many noisy data points. For a 
noisy surface data set, it is recommended to start from a half space with the average apparent 
resistivity value. A data set collected with mixed arrays tends to have a complex pseudosection 
and should start from the average apparent resistivity. 
 

      
 
A borehole data set cannot be displayed in a pseudosection, so it almost always starts from a 
homogeneous half space of the average apparent resistivity value. 
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The custom starting model is meant for educational purpose to test the effect of different starting 
model. It is not recommended for the practitioners. In this custom setting, the user can set the 
resistivity value for the homogeneous half space. 
 
Finally, an advanced option is available for the user to input an a-priori model on the modeling 
mesh. After reading the data file, you may choose the menu item Settings | Input A-Priori 
Resistivity Model. This brings up an interface same as that of the Survey Planner. 
 
4.3.16 Min resistivity  
 
Any resistivity value smaller than this minimum resistivity is constrained to this min value 
during the inversion process. The default value is 1 ohm-m. If you do marine resistivity imaging, 
you should set it to 0.1 (or smaller) because sea water resistivity can be as low as 0.1 ohm-m. 
 
4.3.17 Max resistivity  
 
Resistivity of soils and rocks is rarely over 10,000 ohm-m, a default setting. Moreover, inversion 
may not be able to resolve a very large resistivity contrast. Modify this parameter if you work in 
a very resistive area. 
 
4.3.18 Model parameter width 
 
This combines several model blocks horizontally into a single block. This setting helps suppress 
the lateral variation in the inverted resistivity model for cases of a strongly layered earth or 
surveys on the water. 
 
4.3.19 Resolution factor 
 
The model blocks closer to electrodes usually have a larger sensitivity. The bottom layers in 
surface resistivity imaging and the central area between two ERT boreholes usually have a very 
small sensitivity that results in poor resolution. This resolution factor will, to some extent, 
enhance model resolution in areas with a small sensitivity. Setting this factor to 0 will disable 
this factor. Typical values of this factor range from 0 to 0.3. 0.20 is a preferred default. Note that 
a large resolution factor will also enhance inversion artifacts. 
 
4.3.20 Horizontal/vertical roughness ratio 
 
Set this parameter larger than 1 for an area with a strong lateral resistivity variation, but smaller 
than 1 for a layered earth. Set this parameter to 1.0 if you do not have enough information about 
the geology of your project site. 
 
4.4 IP Inversion Settings 
 
The Induced Polarization inversion has similar settings to those of the resistivity inversion. Some 
resistivity inversion settings that have no counterpart on the IP inversion settings window are 
used to constraint IP inversion. Please refer to the last section (section 4.3) for more information. 
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4.4.1 IP inversion method 
 
EarthImager automatically detects the existence of IP data. If no IP data is found, the IP 
inversion will be disabled. The IP inversion method will be set to No IP Inversion. If IP data 
exists, the IP inversion method will be set to the Linear IP Inversion. Nonlinear IP inversion, 
previously available, was disabled but it may be enabled later subject to further testing. 
 
Linear IP inversion is a fast single-iteration IP inversion method. It is applicable to cases with the 
relatively small intrinsic chargeability such as 100 milliseconds or 100 mV/V. All engineering 
and environmental geophysical investigations would fall into this category. After the completion 
of resistivity inversion, the linear IP inversion will run for a single iteration. 
 
4.4.2 IP window range 
 
The Sting and SuperSting resistivity and IP systems output six windows of integrated 
chargeability measurements. These settings let the user invert the IP data within the desired 
window range. For example, if the last (6P

th
P) window is noisy, you may set the Start Window to 1 

and the End Window to 5, so IP data at the 6P

th
P window would be removed. At least four 

windows are required for a valid logarithmic regression and calculation of correlation 
coefficients. 
 
4.4.3 Min (apparent) chargeability 
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This is the lower bound of the apparent chargeability data in mV/V. Any IP chargeability data 
below this threshold will be removed. 
 
4.4.4 Max (apparent) chargeability 
 
This is the upper bound of the apparent chargeability data in mV/V. Any IP chargeability data 
above this threshold will be removed. 
 
4.4.5 IP Smoothness factor 
 
This is a Lagrange multiplier whose effect is to balance IP data misfit and IP model (roughness) 
constraints. If you have noisy data, a relatively large smoothness factor is preferred. A small 
smoothness factor will produce a relatively rough IP model, but a large smoothness factor will 
produce a relative smooth IP model with a large fitting error.  
 
4.4.6 IP Damping factor 
 
IP damping factor suppresses the effect of small eigenvalues. 
 
4.4.7 Estimated IP noise 
 
Without prior knowledge of the standard deviation of the IP data, you may assume a certain 
percentage of noise/error in IP data. This number usually ranges from 1% to 5% with a default of 
3%. A too large noisy estimate produces a too smooth model. A too small noisy estimate forces 
the inversion to fit data noise and will produce artifacts. 
 
4.4.8 Starting IP model 
 
The IP starting model is handled in the same way as that of the resistivity starting model 
described in the Section 4.3.15 above. 
 
4.4.9 Minimum correlation coefficient 
 
Min Correlation Coefficient is a threshold for noisy IP data removal. Theoretically after cutting 
off the injection current, the IP signal (secondary voltage) would decay exponentially or 
logarithmically. A perfect monotonic exponential delay of IP signal would have a correlation 
coefficient of -1.0. This setting compares the absolute value of the correlation coefficient 
because negative IP data are common and have a positive correlation coefficient. An erratic 
pattern-less IP delay along the six integration windows would have a very small correlation 
coefficient, say less than 0.5. EarthImager removes both IP AND resistivity data when the 
correlation coefficient is smaller than the Min Correlation Coefficient. 
 
4.4.10 Positivity 
 
Intrinsic chargeability of earth materials is a positive quantity. However, the recovered 
chargeability after inversion can be negative if positivity constraints are turned off. To ensure 
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positive chargeability on the inverted IP section, one must turn on the positivity constraint. If 
Positivity is checked, the inverted chargeability values are simply shifted above zero 
(Oldengburg and Li (1994) for linear IP inversion. 
 
4.4.11 Remove negative IP 
 
Check this box to remove all negative apparent chargeability data from the raw data. Negative 
apparent chargeability values are very common in the IP data. Be cautious while enabling this 
setting. 
 
4.5 Terrain Settings 
 
On this page, the user may choose the method for mesh transformation. To invert resistivity data 
with terrain, the fluctuation of surface topography must be adapted into the modeling mesh. First, 
a regular mesh under a flat ground surface is generated. Then the mesh is transformed based on 
the elevation data, i.e., a terrain file, to reflect the flow pattern of electric currents. All nodes are 
shifted vertically only. In the damped transform method, a near-surface node is shifted more than 
a node at the depth. The damped transform method is more applicable to the terrains with ridges 
and valleys. In the uniform transform method, all nodes are shifted up or down the same amount. 
The uniform transform method is more applicable to terrains predominantly with one slope. 
 

   
 
4.6 CRP Settings 
 
The Continuous Resistivity Profiler (CRP) module (optional) in EarthImager 2D processes the 
resistivity and IP data collected with a boat-towed array, or a pulled-array, or a roll-along array. 
CRP uses a Divide-and-Conquer strategy to process large data sets. Refer to the Section 6.8 for 
more information. 
 
4.6.1 CRP 
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The CRP check box enables CRP inversion if this box is checked and you have a large data set 
with many electrodes. It disables CRP inversion when it is unchecked. When EarthImager is 
launched, the CRP option in the dongle (hardware key) is checked. If the dongle CRP option is 
activated, this CRP check box is checked, otherwise, it would be unchecked. To invert a large 
data with the standard (non-CRP) inversion method, uncheck this CRP check box. 
 
In the CRP method, a large data file is split into smaller files (shorter profiles) which are inverted 
in a batch mode. The length of each subsection and amount of overlap between two neighboring 
subsections are determined automatically to avoid merging artifacts. 
 
4.6.2 Axis label format 
 
This is not on the CRP settings window. Instead it is on the tool bar of the main window which 

looks like this . This control has a list of three options which include linear distance,  
longitude/latitude, and UTM coordinates. For marine CRP surveys, linearized distance measures 
in a local coordinate system can not help pinpoint the location of anomalies due to lack of 
landmarks, especially when the boat is not on a straight path. Longitude/latitude and UTM 
coordinates are better options in this case. 
 
4.6.3 Show water depth line 
 
This is a checkbox on the CRP Settings window. By default, a white line is drawn to show the 
water depth and delineate the top water layer. To hide the water depth line, uncheck this box. 
 
4.6.4 Show temperature curve 
 
This is a checkbox on the CRP Settings window. By default, a temperature curve is drawn below 
the inverted resistivity section at the end of CRP inversion if the temperature data is available in 
the water depth file. To hide the temperature curve, uncheck this box. 
 
4.6.5 Fix water resistivity 
 
Checking this box would hold the resistivity of water layer unchanged for the first ten iterations. 
However, the resistivity of water layer may NOT be a constant if a water conductivity file is 
inputted or the average water resistivity is NOT given in the water depth file. 
 
4.6.6 Number of electrodes per subsection 
 
The CRP inversion module uses a divide-and-conquer strategy to process a long profile to save 
time and computer memory. A long profile is divided into many subsections. All subsections are 
inverted one by one. At the end, inverted results from all subsections are combined together to 
form a long inverted section. This setting and the following ones control how to divide a long 
profile and make sure that there is no gap between neighboring subsections and no severe 
merging effect on the final inverted section. The number of electrodes per subsection sets the 
minimum number of electrodes per subsection. For a marine data set, it is recommended to set 
this parameter to 200 or higher. For a data set collected on land surface with a roll-along array or 
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a pulled array, set this parameter to 100 or higher. To be safe, always start with the default 
settings. 
 
4.6.7 Percent of overlap and number electrodes to overlap 
  
To make sure that there is no gap between neighboring subsections and no severe merging effect 
on the final inverted section, set Percent of Overlap to 60% or higher. The Number of Electrodes 
to Overlap, a read-only field, equals to the product of Number of Electrodes per Subsection by 
Percent of Overlap. 
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5. SURVEY PLANNER 
 
5.1 Survey Planning Process 
 
Our survey planner is a two-step process. First, a synthetic data is created based on your 
assumption of subsurface resistivity distribution and electrode configuration, i.e., a command 
file. This step is a virtual survey and also called forward simulation.  
 
Second, the synthetic data is inverted to reconstruct the subsurface resistivity distribution. Your 
assumption of resistivity distribution and the inverted resistivity section will be displayed on the 
screen. The second step is called inverse simulation. You may find out if resistivity imaging is 
feasible or appropriate to attack your problem.  
 
Any failure to reconstruct the assumed resistivity distribution may be caused by 1) a not 
optimized command file, 2) incorrect forward modeling settings, 3) incorrect inversion settings, 
and/or 4) inability of resistivity imaging to solve your problem such as too small resistivity 
contrast, too small target, and/or too large depth of the target. It is suggested that you try 
different command files, different forward modeling settings, and different inversion settings. 
You may also vary the properties of your target.  
 
The goals of our survey planner are to help you: 

1) find the optimal data collection strategy, i.e., the command file, 
2) find the optimal forward modeling settings, 
3) find the optimal inversion settings, and 
4) find the limit of resistivity imaging, that is, what resistivity contrast, what target size, 

what target depth and/or what kind of subsurface geology the resistivity imaging can 
resolve. 

 
Survey planning for both surface resistivity imaging and cross borehole resistivity tomography is 
supported. EarthImager detects the type of surveys automatically based on the electrode 
geometry. So the difference between the surface and borehole survey planning is minimal to the 
end user. Since the Version 2.0.3 we added a new IP Survey Planner module, which one has to 
purchase additionally.  
  
Our survey planner helps you achieve these goals without costly trial-and-error tests in the field. 
Therefore you will make the right decision from the beginning. 
 
5.2 Forward Simulation 
 
Forward simulation is the first step of survey planning. It runs a virtual survey and creates a 
synthetic data set. It is preferred to select appropriate settings before loading a command file or a 
model file. To run forward simulation, follow these steps: 
 

1) Choose Read Command File from the File menu or go to the next step. This will load 
an AGI command file (*.cmd) and create a mesh based on the initial settings after 
successful loading of the command file or a model file. For a SuperSting command 
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file, a dialog box will pop up to ask the user to input the scaling factor of electrode 
geometry because the electrode spacing in the SuperSting command file is one meter 
or one foot by default. If your electrode spacing is not 1 m or 1 ft, you should enter a 
scale factor other than 1.0 here. 

 

 
 

2) Choose Read Model File from the File menu. This will load an AGI model file 
(*.mdl). A model file consists of measurement commands, a synthetic model, and 
mesh settings. 

3) Choose Forward Modeling Settings from the Settings menu and change the settings as 
you desire. It is preferred to do this before you build the model or even before you 
read the command file or the model file. Otherwise your model may be lost and you 
have to rebuild the model. 

4) The Model Settings panel would appear to the right of the main window. To hide this 
panel, right-click the mouse on the panel and choose the only option “Hide model 
settings panel”. This panel may also be turned on or off by choosing the menu item 
Settings | Synthetic Model Settings. Note that there are two tabs at the top right corner 
of the Model Settings panel: Resistivity and IP. To build a resistivity model, use the 
settings and controls on the Resistivity page. To build an IP model, use the settings 
and controls on the IP page. For IP simulation, both resistivity and IP models must be 
built before starting the simulation (or modeling). It is also important to note that 
resistivity and IP anomalies often have the same source. 
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5) If borehole electrodes are detected, the Survey Planner would enter the Electrical 
Resistivity Tomography (ERT) mode automatically. A typical ERT mesh may look 
like this. 

 

 
 

6) Input background resistivity in ohm-m. Background is white by default. To assign a 
color to the background, click the Color Background button. This will add the 
background resistivity to the list and the color scale and color the entire mesh in a 
single color. The background color may vary depending on the number of anomalous 
resistivity values.  

7) Add or remove anomalous resistivity values. Five default values are 10, 20, 100, 200, 
1000 ohm-m.  Input resistivity value in the text box above the Add and Delete 
buttons, and then click the Add button. The resistivity values in the list are 
automatically sorted in an ascending order. The color scale in Main Window will 
reflect your changes. 

8) To delete an anomalous resistivity value from the list, click the item you desire, and 
then click Delete button. 

9) To Show the horizontal location and depth of current mouse pointer in the mesh, 
check Show (X, Y) box. Note that there is vertical depth exaggeration. 

10) To select a block in the mesh, click the block you desire. Selected blocks turn black. 
11) Click and hold the left mouse button and drag it. The blocks on the moving path of 

the mouse pointer will be selected. If you start or end your dragging out of the mesh, 
your selection will be invalid, i.e., nothing is selected. For a fine mesh with over 56 
electrodes, drag slowly. 

12)  To select one layer, click the layer while holding down the Shift key. 
13)  To select the left side of the current layer at the mouse cursor, click the Left 

mouse button while holding down the CTRL key. To select the right side of the 
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current layer at the mouse cursor, click the Right mouse button while holding 
down the CTRL key. 

14)  To select a column, click the middle mouse button or mouse wheel. 
15) To assign a resistivity value to the selected blocks, click the desired color in the 

resistivity color scale. 
16) Keep in mind that the model mesh on the screen is the core mesh. The actual mesh 

will extend to the “infinity” to the left and right and at the bottom. Any anomalous 
resistivity block you place at the left or right or bottom edge will be duplicated to the 
“infinity”. That is, a single block of any anomalous resistivity at the edge of the core 
mesh will become a layer or an infinitely extended dike in the boundary mesh. 

17)  To clear the current selection, click the Clear Selection button. This will clear the 
blocks highlighted in black only. 

18)  To clear both the selected black blocks and colored blocks, click the Clear All 
button. 

19) To add random noises to the resistivity (and IP if selected) simulation data, set 
Random Noise to a non-zero value. Note that the measurement noises and numerical 
errors are usually below 3%. 

20)  Build an IP chargeability model the same way as one builds a resistivity model with 
controls and settings on the IP page. After clicking the IP tab, you will notice that the 
resistivity model is shaded on the IP modeling mesh. Be sure to check the IP 
Simulation box first to activate all IP controls. If the IP Survey Planner module is not 
purchased, the IP model settings page is disabled and can not be enabled. 

 

 
 

21)  Choose Forward Simulation from the Tool menu. This will start the forward 
simulation. For surface surveys, you will see an apparent resistivity pseudosection at 
the top and the actual model on the bottom of the main window. If the IP simulation 
is activated, resistivity forward simulation is carried out first, then IP forward 
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simulation. Shown below are results of resistivity and IP forward simulation with a 
surface dipole-dipole command file. 

 

   
 

22) For borehole resistivity imaging, the synthetic model will be shown to the left and the 
apparent resistivity or chargeability scatter plot to the right. 

 

 
 

23)  To format the graphics, choose tool buttons on the top toolbar under the main menu. 
24)  To browse graphics at different views, choose desired menu item from View menu: 

Synthetic Model, and Synthetic Model and Data. 
25)  You may save or print your on-screen image through the File menu or tool buttons. 
26)  A synthetic model file (*.mdl) is saved in the current trial folder at the end of 

forward simulation. You may also save the model file by choosing the menu File | 
Save Synthetic Model. 

 
At the end of forward simulation, you will find four files saved in the current trial folder 
automatically. The INI file is a formatted inversion settings file and may be loaded into 
EarthImager later. The OUT file contains some descriptive information but it is not very useful 
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here. The STG file contains synthetic data and may be read into EarthImager for inversion. The 
MDL is a model file that contains commands, forward modeling settings, and the model you 
built. The MDL file may be read into EarthImager for forward simulation and survey planning, 
so you do not have to rebuild the model from scratches.  
 
5.3 Survey Planner 
 
The survey planner is a combined forward and inverse simulation. First a virtual survey is carried 
out by forward modeling (simulation) to generate a synthetic data set. Then the synthetic data set 
is inverted to reconstruct the subsurface model which is compared against the synthetic model 
for resolution analysis. To run Survey Planner, follow steps (1) through (17) of forward 
simulation. In addition, you should 
 

1) Choose your inversion method from the Initial Settings page of the Settings Window, 
2) Set your desired inversion settings from the Resistivity Inversion settings page of the 

Settings Window.  
3) If IP inversion is planned, choose appropriate IP inversion settings. This should be done 

before loading the command file. 
4) The estimated noise percentage and stopping RMS on resistivity and IP inversion settings 

windows should be always equal to or greater than the random noise added to synthetic 
data. 

5) Instead of choosing Forward Simulation, choose Survey Planner from the Tools menu. 
6) You will see the forward simulation graphics first, and then inversion images. 
7) For the surface resistivity surveys, three images are shown. The top one is the synthetic 

apparent resistivity (or chargeability) data pseudosection. The middle one is the inverted 
resistivity (or chargeability) section. The bottom one is the synthetic resistivity (or 
chargeability) model. It is important to compare the synthetic model with the 
reconstructed model and to understand the resolution of resistivity/IP imaging. You 
should note that it is impossible to recover the exact subsurface resistivity distribution. 
Instead, you get a smooth model after the inversion.   

 

  
 

8) For IP survey planning, inverted resistivity and chargeability sections are shown at the 
end of IP inverse simulation. 
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9) For borehole resistivity tomography, the synthetic resistivity model and the reconstructed 
model are shown side by side for comparison. 

 

 
 

10) To format the graphics, choose tool buttons on the top toolbar under the main menu.  
11)  To browse graphics at different views, choose the desired menu item from the View 

menu: Synthetic Model, Synthetic Model and Data, and Survey Planner Results. The 
survey planner results are images described in the steps 7) and 9). 

12)  For IP survey planning, one may click the Resistivity or IP tab at upper left corner of the 
main image window to toggle between the resistivity and IP images of the same layout. 

 

 
 

13)  You may save the onscreen image in a bitmap file. 
14) You may save the inverted resistivity section in a text file in the XYZ format.  

 
5.4 A-Priori Model 
 
While building a synthetic model, one may set part of the model as a-priori model which will 
remain unchanged during inversion of synthetic data. By constraining part of the model with 
known information, one has a better chance to resolve the unknown part of a synthetic model. 
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Check the box “A-Priori Model” (see above) before picking/selecting model blocks. The model 
blocks selected after checking the “A-Priori Model” box will be held constant during the 
simulation. Be sure to uncheck the box if the following model blocks are not going to be set as a-
priori model. In the example above, a 10 Ohm-m conductive block is set as a-priori model, 
otherwise, the survey planner would not be able to resolve it so accurately. The a-priori model 
status can be saved in the synthetic model file and read back into EarthImager 2D. 
 
5.5 Survey Planner with Underwater Electrodes 
 
This case is the same as the borehole electrodes. The electrodes can be either underwater or 
underground. One should set the water layer as the a-priori model by using the feature described 
in the last section. 
 
Set negative Z coordinates to indicate the depth of electrodes in the electrode geometry file. 
There is a sample GEO file (underwater.geo) and a corresponding model file (underwater.mdl) in 
the demo folder. In this model, the top blue layer is set as a-priori model. 
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5.6 Survey Planner with Topography 
 
This feature helps simulate resistivity surveys with topography. Electrodes in a command file are 
assumed to be laid out on a flat ground surface. Elevation measurements are listed in a terrain 
file. It is important to maintain an agreement of distance measurement format between the 
command file and the terrain file. This is the same requirement as that in topographical data 
inversion described in the section 6.1. The screenshot below is a synthetic scenario and it 
demonstrates how the survey planner with topography looks like.  
 

 
 
To model the topography, follow these steps: 
 

1) Read a command file, for example, Dip56R8.cmd in the demo folder. Use a scale factor 3 
for this SuperSting command file. A mesh with flat ground surface would show up. 

2) Read a terrain file, for example, pyramid.trn in the demo folder. The mesh would be 
transformed to fit the topography. If the mesh does not change, you may want to change 
the default settings to Surface and reload both command file and terrain file. 

3) Build the synthetic model as usual. 
4) Start either Forward Simulation or Survey Planner. 
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6. BEYOND THE BASICS 
 
 
6.1 Inversion with Terrain 
 
Resistivity survey with topography possesses two difficulties. First, electrode positioning on 
topographic surface is more difficult than that on flat ground surface. Second, inversion of 
resistivity data with topography is challenging. EarthImager has a highly optimized finite 
element algorithm so your inversion with topography will be extremely fast and reliable. By the 
way, we provided a flexible format of terrain files, so it is easier for you to position the 
electrodes in the field. 
 
6.1.1 Terrain file format 
 
EarthImager has no restrictions on the electrode spacing and array configuration. Electrodes may 
be placed anywhere you prefer. You have two ways to tell EarthImager your electrode geometry. 
First, you may use horizontal distance that is equivalent to the horizontal coordinate. Second, 
you may use tape measure or slope distance whose projection on the flat surface is the horizontal 
coordinate. Here is a sample terrain file. 
 
; TRN File                           // A semicolon (;) starts a comment line  
unit=meters                        // Unit of distance measure 
2                                          // 1 = horizontal distance is given, 2 = tape measure is given 
-1, 0.3                                  // X, elevation (positive upward) 
1.0, -0.3 
3.6, -1.2 
6.1, -2.7 
7.4, -2.3 
9.0, -1.3 
10.5, -1.0 
13.7, -1.5 
15.2, -2.5 
17.0, -1.0 
19.2, -0.2  
 
The terrain file (*.trn) is a comma separated text file that may be created in any text editor such 
as the NotePad. 
 
6.1.2 Run inversion with terrain 
 
1) Click the Read Data button, e.g., Pyramid.stg. 
2) Modify inversion settings if you desire. Default surface settings are a safe option for surface 

data. 
3) Click File/Read Terrain File, e.g., Pyramid.trn. 
4) Click the green Start Inversion button. 
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Inversion of resistivity data with topography uses the finite element modeling method because 
the triangular mesh of finite element method is very flexible to cope with topographical 
variations. The sensitivity and inverted resistivity sections will show variations of surface 
elevation. The vertical axis is labeled with the elevation instead of the depth in a standard 
inversion without terrain. Borehole data inversion with topography was supported from the 
version 1.7.7, but there is no field ERT data with terrain in our release. To demonstrate borehole 
data inversion with terrain correction, the user may invert ERT3bh.stg with the tweaked terrain 
file ERT3bh.trn. 
 

 
 
 
6.2 Input A-Priori Information 
 

1) Click the Read Data button. 
2) Modify inversion settings if you desire. 
3) Click Settings/Input A-Priori Information menu to display the GUI interface to build a 

synthetic model. 
4) Follow the instruction in Section 5.2 about how to build a synthetic model. 
5) Click the green Start Inversion button. 

 
A-priori resistivity value deviated from the true subsurface resistivity greatly would slow down 
the inversion process and impose artifacts on the inverted resistivity section. The inversion 
process would NOT retain an erroneous a-priori resistivity value.  
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6.3 Time Lapse Inversion 
 
The optional Time Lapse Inversion module is used for in-situ monitoring applications. It could 
be, for example, used to detect leakage at a landfill site, a dam, or underground storage tank. In 
such a case, electrodes are installed at fixed locations during the period of monitoring to facilitate 
image comparison and high sensitivity of small changes in the ground. First, a base (or baseline, 
background) resistivity data set is collected, so a base resistivity model of the site can be 
established as a reference model. Then, the monitor survey is repeated during the period of 
monitoring with the same command file as the one used in the base survey. Our Time Lapse 
Inversion algorithm takes advantage of the base survey data and base resistivity model. Instead 
of inverting the monitor data set alone, our algorithm inverts the difference between the monitor 
and base data sets. Moreover, the base resistivity model is used as the a-priori model in the time 
lapse inversion. Therefore, our time lapse inversion converges faster than standard inversion and 
is more sensitive to small subsurface changes. The coherent inversion artifacts may be canceled 
in the difference images. 
 
A time lapse monitoring application may have one base dataset and one or more monitor 
datasets. The time lapse inversion produces difference images between any monitor dataset and 
the base data set. 
 
The result of time lapse inversion is presented as the percent difference between the two sections. 
The time lapse method may be used for monitoring of any subsurface processes. Some common 
situations include potential leakage from landfills, dams and underground storage tanks. Other 
monitoring situations include fracture tracing by injection of a conductive solution such as a salt 
solution, saltwater intrusion in coastal areas, environmental remediation progress, groundwater 
recharge, infiltration studies, and so on. 
 
The time lapse inversion may be carried out in two different ways depending on the type of 
input. Difference inversion accepts two raw data files (STG) as inputs. This is a comparison of 
before and after images. Time lapse inversion requires the output of base data inversion and 
inverts a list of monitor data sets in a batch mode. 
 
6.3.1 Difference inversion 
 
Difference inversion combines the inversion of the base dataset and time lapse inversion of a 
single monitor dataset in one step. It is applicable to the cases with one base dataset and a single 
monitor dataset.  Here are the steps to follow for a difference inversion. 
 

1) Start EarthImager 2D. A dongle option code for time lapse inversion must be activated in 
order to proceed with the difference inversion. 

2) Choose the menu Inversion | Time Lapse Inversion and then the “Difference Inversion” 
tab. 

3) Input the base data file by clicking the corresponding Browse button. The demo data set 
is C:\Program Files\AGI\EarthImager2D\demo\TimeLapse0.stg. 

4) Input the monitor data file by clicking the corresponding Browse button. The demo data 
set is C:\Program Files\AGI\EarthImager2D\demo\TimeLapse1.stg. 
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5) Input a terrain or underwater terrain file if any. 
6) Choose “Same Command File” or “Different Command Files”. It is strongly 

recommended that you use the same command file for the base data and monitor data 
collections. 

7) Change the inversion settings by clicking the “Change Settings” button. 
8) Start Difference Inversion. EarthImager will invert the base dataset first and then do a 

difference inversion of the monitor dataset. The inverted results at the optimal iteration 
based on the RMS error and/or L2-norm will be saved in the output (OUT) file, which 
may be loaded back into EarthImager for custom settings and visualization. 

9) At the end of difference inversion, percent difference of resistivity image is shown. It is 
preferred to set the absolute value of minimum and maximum plot bounds to be equal, so 
zero (no change) will be in the center of the color scale and in a green color by default. 

10) In addition to all images for standard data inversion, we provided two more images for 
time lapse inversion: percent change of resistivity and percent change of conductivity, 
under the menu item View | Time Lapse Images. 

 

   
 
 
6.3.2 Time lapse inversion 
 
The difference inversion scheme in the last section requires inversion of the base dataset for 
every monitor dataset. This turns out to be unrealistic for a long term monitoring application that 
usually has many monitor datasets. So we developed a time lapse inversion scheme that can 
handle a large number of monitor datasets in a batch mode and output an AVI movie file at the 
end of the batch inversion.  
 
In our time lapse inversion scheme, the base dataset must be inverted first like a standard 2D data 
inversion. We suggest that the user runs the inversion of base dataset two or more times to clean 
up the base dataset with the histogram. However, excessive data removal is discouraged because 
any data point removed from the base dataset will also be removed from all monitor datasets. 
The inversion output file of the base dataset is served as the input of the time lapse inversion. All 
monitor datasets are inverted with the base inversion results as the a-priori information. 
To start the time lapse inversion, follow these steps. 
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1) Choose the Time Lapse Inversion menu item from the Inversion menu and select the 
Time Lapse Inversion page. Make sure that the base dataset has already been inverted. 

 

 
 

2) Input the Base Inversion Output (*.out) File by clicking the Browse button. This file 
consists of previously inverted results of the base dataset. The base inversion output is 
served as the a-priori information of the time lapse inversion. While adding the OUT file 
to the input box, EarthImager checks the availability of the inversion settings file in the 
same folder of the OUT file. The settings file will be used for the time lapse inversion. It 
is preferred that the same settings are used for both base data inversion and monitor data 
inversion.  

3) If a terrain (*.TRN) or underwater terrain (*.UWT) file exists in the base inversion output 
folder, it will be used in the time lapse inversion. 

4) Add monitor data files to the list. There are two ways to add monitor data file names. 
First, the user may click the “Add Monitor Data Files” button and select multiple data 
files from the Windows File Open Dialog. Second, an ASCII batch file with a list of 
(STG) data file names and, if any, the base output file name may be loaded into 
EarthImager 3D. A batch file is a simple list of file names with a complete file path. If an 
OUT file is found in the batch file, it will overwrite the OUT file already in the input box. 
But the monitor data files will be simply appended to the current monitor file list without 
any check on duplicates. Here is a sample time lapse batch file: 

 
C:\Program Files\AGI\EarthImager2D\demo\TimeLapse0\trial1\TimeLapse0_trial1.out 
C:\Program Files\AGI\EarthImager2D\demo\TimeLapse1.stg 
C:\Program Files\AGI\EarthImager2D\demo\TimeLapse2.stg 
C:\Program Files\AGI\EarthImager2D\demo\TimeLapse3.stg 

 
5) To delete a monitor file from the file list, select the file and then press the Delete key. To 

change the order of a monitor file, use the Up and Down arrow to move it up or down. 
All monitor files must be listed in a sequential order based on the data collection time 
because an AVI movie will be created at the end of inversion to show time lapse changes. 
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6) Save the batch file for future use. 
7) The user may change the inversion settings by going to the Main Window and choosing 

any settings page, but this is strongly discouraged. 
8) An AVI movie file may be produced with the difference images from all monitor datasets 

when three or more monitor datasets are inverted in a batch mode. To create an AVI file, 
all difference images must be presented with the same color scale and data range (Min 
and Max).  

9) Set Min Change and Max Change based on the above discussion and convention. It is 
going to be difficult to set these two numbers without any prior knowledge. We 
recommend that you set Min-Change = -1 * Max-Change. This will help suppress some 
artifacts and make the green color no-change zones. 

10) The selection of the plotting Parameter will depend on the application type. For a case 
with increasing conductivity, it is almost mandatory to choose “Conductivity Change” as 
the parameter to plot. For a case with increasing resistivity, select “Resistivity Change” 
as the plotting parameter. Choice of Min Change, Max Change and Parameter is not fatal 
but an inappropriate selection will fail the attempt of AVI movie creation. The time lapse 
inversion results can be read back into EarthImager for visualization and data analysis.  

11)  Click the Start button to start the time lapse inversion in a batch mode. The monitor data 
files are inverted one by one.  

12) At the end of inversion of each monitor data set, the inverted resistivity data is saved as 
images in the JPG and BMP formats and ASCII XYZ format. Moreover, both resistivity 
difference and conductivity difference between the monitor model and base model are 
saved in the bitmap format and ASCII XYZ format. Here are some typical output files 
from a time lapse inversion of one monitor dataset. Bitmap files are used to create an 
AVI movie to demonstrate the animated time lapse change of the subsurface. Go the 
Create AVI Movie under the Tools menu for detail. Three images below demonstrate 
gradual decrease of the subsurface resistivity from synthetic data sets. 
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13) The size of a saved image would have the same size of the image rendering window. 
14)  A time lapse inversion output file may be read back into EarthImager one at a time for 

visualization and further data analysis. This will be discussed in the next section. 
15) At the end of inversion, an AVI movie file is created and played automatically if three or 

more monitor data sets are inverted in a batch mode. 
 
6.3.3 Read time lapse output file 
 
To load the time-lapse inversion results back into EarthImager, go to the menu item File | Read 
Time Lapse Output File or the menu Inversion | Time Lapse Inversion and then choose the page 
“Read Time Lapse Output File”.  
 
Trial directories for both base data inversion and monitor data inversion are required to produce 
the percent difference images. The user is simply prompted to choose or enter these two 
directories. Note that the inversion settings (INI) files in these two directories must be intact for 
successful display of difference images. 
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6.4 Inversion of ERT Data 
 
When you look at the CAVE.STG and AMISTAD.STG, you may find that abs(V/I) is in the 
range of 10P

-2
P ~ 10P

0
P. ERT data is usually noisier due to the large dynamic range of signal, i.e., V/I 

varies from 10P

-6
P ~ 10P

0
P. These small V/I's are usually extremely hard to fit and produce a large 

RMS. So RMS may be a misleading measure to show ERT data misfit. Here are some tips for 
ERT data inversion. 
 

• Remove Noisy Data When Reading the STG File 
 

1) Minimum abs(V/I). Change settings before reading the file. The data rejection threshold 
is on the Initial Settings window. Min V/I should be set between 10P

-4
P and 10P

-3
P. 10P

-4
P is a 

too conservative setting. Any V/I data smaller than 10P

-3
P are usually hard to fit and 

produce very large RMS. But you are not supposed to remove all of them. The Suppress 
Noisy Data setting on Resistivity Inversion settings window will give less respect to 
hard-to-fit data.  

2) Negative apparent resistivity is common in ERT data. You are not supposed to remove all 
of them. Negative apparent resistivity data are always shown in black dots in the ERT 
data scatter plot. There are often many troublemakers that have a negative apparent 
resistivity. The horizontal or vertical linear feature of black dots is the sign of bad 
electrodes. 

3) Apparent resistivity threshold should be set based on the common sense.  
 

• Edit ERT Data 

 Page 88 of 140



Instruction Manual of AGI EarthImager 2D, 2014-11-24 

 
1) Edit Electrodes. If you see any horizontal or vertical linear feature of black dots on the 

ERT data scatter plot, go to the Electrode Editor under the Edit menu and remove the bad 
electrode. By the way, all data associated with the bad electrode will be removed at once. 

2) Edit ERT Data. After you read the ERT data file, the ERT data scatter plot is the interface 
to edit the data one by one. Select the noisy data by mouse clicking and remove it with 
the Delete key. Noisy data may be defined as a very small or very large apparent 
resistivity, or a negative apparent resistivity, or any standout data point on the scatter 
plot. You may repeat this on the data misfit scatter plot after the inversion is done, 
removing poorly-fit data. 

 
• Resistivity Inversion Settings 

 
1) Choose a stabilizing factor >= 100 because noisy ERT data usually produce a rough 

model. A larger stabilizing factor leads to a smoother model. 
2) Choose a Resolution Factor >= 0.20, e.g., 0.25, to enhance the resolution in the central 

part of two boreholes.  
3) Choose a Horizontal / Vertical Roughness ratio <= 0.5 to force a layered earth in the 

inverted model. This may exacerbate the borehole or electrode effects. 
4) Check ‘Suppress Noisy Data’. This will treat hard-to-fit data with less respect. The stop 

criterion “L2-Norm” will be automatically checked. The inversion will stop when the 
normalized L2-norm reaches 1. 

 
 
6.5 Inversion of IP Data 
 
Our IP inversion algorithm is adapted from Method I of Oldenburg and Li (1994). Instead of a 
subspace inversion method, EarthImager uses the conjugate gradient method to solve the linear 
inverse problem. AGI Sting and SuperSting collect time domain IP data. 
 
6.5.1 Units of IP chargeability 
 
Chargeability is defined as the induced secondary voltage immediately after the cutoff of the 
current injection normalized by the primary voltage with the transmitter on. So it is, in fact, a 
dimensionless quantity. Because the measurement of initial secondary voltage is not possible, 
different measurement methods with various delay times and integration windows result in many 
chargeability units.  
 
There are two chargeability parameters to deal with in IP modeling: intrinsic chargeability 
(model) and apparent chargeability (data). Like soil or rock resistivity, intrinsic chargeability is a 
physical property of medium and it stays constant no matter how one measures it. Apparent 
chargeability instead is an integrated subsurface response that depends on subsurface 
chargeability model, array type and instrument settings such as delay time and window width. 
Both intrinsic and apparent chargeability data share the same unit. The objective of IP inversion 
is to recover subsurface intrinsic chargeability model from apparent chargeability data. 
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IP chargeability may be measured in either the time domain or the frequency domain. The 
chargeability units in the time domain can be either milliVolt/Volt (mV/V) or millisecond (ms). 
The chargeability units in the frequency domain include percent frequency effect (PFE) or 
milliradian (mrad). AGI Sting and SuperSting resistivity and IP systems are time domain IP 
instruments. The chargeability in AGI STG data file is in unit of seconds with six integration 
windows. 
 
Newmont M331 standard was based on a transmitter cycle of 3s +on, 3s off, 3s –on and 3s off 
and an integration of the secondary voltage from 0 to 1s. Numerically M331 in units of seconds 
equals chargeability in units of V/V or dimensionless chargeability. This transmitter cycle of 12s 
= 3s x 4 has rarely been used. The Newmont IP system actually had a transmitter cycle of 2s 
+on, 2s off, 2s –on and 2s off and an integration of the secondary voltage from 0.45s to 1.1s. The 
chargeability measured with this type of instrument was converted to M331 chargeability by 
multiplying an empirical factor of 1.87. This factor works only for Newmont IP systems. After 
conversion, chargeability in ms would be equal to chargeability in mV/V numerically. For any 
other transmitter waveform and integration time window, a new calibration factor is needed for 
conversion of chargeability to Newmont M331 standard. 
 
EarthImager requires an input of dimensionless IP chargeability. Refer to Oldenburg and Li 
(1994) for more information about linear IP inversion. Inverted IP chargeability may be 

displayed in milliseconds or mV/V via a tool button  or . If the unit of your IP data does 
not agree with the Newmont M331 standard, a conversion must be carried out prior to the IP 
inversion. 
 
6.5.2 IP data Editing 
 
There are three ways to identify and remove noisy IP data. First, some thresholds for removal of 
noisy resistivity data may help identify and remove some noisy IP data. Second, there are three 
thresholds for identification and removal of noisy IP data on IP Inversion Settings tab: Min 
Chargeability, Max Chargeability and Min Correlation Coefficient. Finally, there is an 
interactive manual editing tool under the menu Edit | Edit Surface IP Data to visualize IP decay 
curves and edit IP data manually by pressing the Delete key. 
 
On this Edit Surface IP Data image, the apparent IP chargeability scatter plot is shown at the 
bottom and an IP decay curve at six windows for a specific data point is shown at the top. You 
may click any data point to visualize its IP decay (red line). A black dashed line is an ideal 
logarithmic decay curve obtained from a logarithmic regression. The deviation between the red 
line and black dashed line is characterized by a correlation coefficient shown on the bottom 
status bar which all lists injected current and measured voltage. A blue dotted line indicates 0 
chargeability.  
 
There are two more features in this Edit Surface IP Data tool from the popup menu by right-
clicking your mouse. Animate IP Data Scatter Plot will show IP decay curve of all data points 
one at a time by following the measurement sequence at a fixed 800ms interval. The vertical 
scale of IP Decay Curve can be defined by min-max of current data point by default or Use IP 
Data Set Min-Max from the popup menu. The latter option uses min-max of the entire data set so 
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that some decay curve may appear flat due to small signal. You may toggle this popup menu to 
switch this option back and forth. 
 
One may notice that there is a discrepancy between apparent chargeability on the decay curve 
and that on the scatter plot. The apparent chargeability on the scatter plot is the ratio of 
secondary decay voltage to the primary voltage at the moment of measurement delay. This is a 
derived quantity through a logarithmic regression. Its unit is mV/V from Vs / Vp. The apparent 
chargeability on the decay curve is directly from an IP instrument such as AGI SuperSting R8. It 
is defined as a ratio of an integration of a secondary voltage decay curve within a time window to 
the primary voltage. Its unit is seconds or milliseconds from Vs * t / Vp. 
 

 
 
 
6.5.3 Inversion of IP data 
 
There is only one IP inversion method available at this time: linear IP inversion. EarthImager 
automatically detects the existence of IP data and the type of IP data such as surface IP survey or 
borehole IP tomography. EarthImager inverts both surface and borehole IP data. Refer to the 
section 4.4 for more information about IP inversion settings.  
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The inversion of resistivity data is a must step in the inversion of IP data and it produces the 
background resistivity model for the IP inversion. IP data always coexists with resistivity data. 
To invert an IP data set, follow these steps. 
 

1) Launch EarthImager. 
2) Read Data from the File menu or the tool button . 
3) To remove noisy IP data without a good exponential decay, set an appropriate Min 

Correlation Coefficient, say, 0.7. Note that both IP AND resistivity data will be removed 
at the same time. This setting stays active until you Start Inversion. 

4) To view IP data, go to View | IP Images | IP Raw Data menu item (optional). 
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5) Edit resistivity data using Edit | Edit Surface AppRes Data or Edit | Electrode Editor. An 
IP data point will be removed simultaneously when one removes a resistivity data point. 

6) To edit surface IP data, go to Edit | Edit Surface IP Data. A resistivity data point will be 
removed simultaneously when one removes an IP data point. To edit borehole IP data, go 
to View | IP Images | IP Raw Data to bring up IP data scatter plot. 

7) To check IP data quality, go to View | IP Images | IP Data Correlation Scatter Plot. IP 
measurements at six time windows are fit to an exponential decay curve using regression. 
This plot shows the correlation coefficients. Negative one (-1.0) indicates a perfect 
exponential decay. You may remove any IP data point from this image based on its 
correlation coefficient. 

 

 
 

8) Invoke IP positivity if so desired. Note that this positivity constraint simply shifted entire 
inverted IP model to the positive values. 

9) View inverted resistivity and IP results from the View menu. 
10)  To remove poorly-fit IP data, go to View | IP Images | IP Data Misfit Histogram. You 

remove some hard-to-fit data and re-run the inversion for a smaller RMS error. 
11) Add a border to the graphics by choosing Input Title and Job Data from the View menu 

or the popup menu. 
12) Save the onscreen image as a bitmap file or a text file in XYZ format from the File menu 

or using the popup menu. 
13)  Print the onscreen image. Choose a desired printout resolution from the Page Setup 

window under the File menu. 
 
One should not try to interpret any inverted chargeability anomaly less than 10 mV/V, which is 
the background chargeability of common earth media. 
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6.6 Batch Inversion 
 
Batch inversion processes many data files in a batch mode without interruption. Its input is a 
batch file (*.bch) containing a list of data file names and inversion settings file names. Here is an 
example of a batch file: 
 

C:\Program Files\AGI\EarthImager2D\demo\cave.ini 
C:\Program Files\AGI\EarthImager2D\demo\Amistad.stg 
C:\Program Files\AGI\EarthImager2D\demo\cave.stg 
C:\Program Files\AGI\EarthImager2D\demo\ERT3bh.ini 
C:\Program Files\AGI\EarthImager2D\demo\ERT3bh.stg 
C:\Program Files\AGI\EarthImager2D\demo\IPtest1.stg 
C:\Engineering\Projects\pc\Volente\DemoData\terrain.ini 
C:\Engineering\Projects\pc\Volente\DemoData\terrain.stg 
C:\Engineering\Projects\pc\Volente\DemoData\terrain.trn 

 
EarthImager reads these files one by one. When EarthImager reads an INI settings file, it updates 
the inversion settings and uses these settings for inversion of the next data file. When 
EarthImager reads a data file (*.stg, *.dat), it starts inversion of this data set, and saves the 
inverted resistivity section, and IP section if available, as a JPEG image file and a text data file in 
the XYZ format. The chosen iteration has a minimum L2 norm if Suppress Noisy Data is 
checked or has a minimum RMS error. If EarthImager detects a terrain file (*.trn) immediately 
follows a data file, it will carry out the inversion with terrain correction. Any file with a file 
extension other than INI, STG, DAT and TRN will be ignored. Incompatible data files will be 
skipped. Any surface data file with one or more reference (infinity or remote) electrodes may be 
skipped if it has a non-zero Y coordinate for the infinity electrode. 
 
To start batch inversion, choose the Batch Inversion menu item from the Inversion menu. The 
batch inversion interface will show up. 
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Here are the steps to carry out the batch inversion. 
 

1) Load a batch file (*.bch). A batch file is a text file containing a list of file names. See the 
example batch file above. You may create a batch file in any text editor such as the 
NotePad or in this batch inversion interface.  

2) Add data and/or settings files to the list. You may add more data and settings files to the 
list even if you already loaded a batch file. To select and add more than one files at a 
time, use the mouse button and the CTRL or SHIFT key. 

3) Remove files added by mistake. Select the file and press the Delete key. You may also 
select many files at once by holding down the mouse button and drag. Then a single 
Delete key press will delete many files. 

4) You may move one or more files up or down using the Move Up or Move Down button. 
To move a file, you need to select it first. This function is helpful when the INI settings 
file is not at the right position or the terrain file (*.TRN) does not immediately follow the 
corresponding data file. 

5) After all adding and editing, now you may save the file list as a batch file (*.bch) so you 
may load it back. 

6) To save inverted section in an XYZ format without two triangular edges, check the 
“Exclude Edges” checkbox. For more information about this, refer to the Section 3.11. 

7) To add a border and a project information table to the graphics, click the Project Settings 
button. 

8) Start Batch Inversion. The data files in the list will be inverted one by one and you may 
monitor the inversion progress on the screen. Inverted resistivity section (and IP section if 
applicable) at the iteration with the minimum RMS error will be saved as a text file in the 
XYZ format and a JPEG graphics file. All inversion results are also saved in the OUT file 
that may be loaded back to EarthImager for analysis. 
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Note that user interactions are skipped in the batch mode. Therefore, you can not edit the data 
and customize your graphics. In this case, you may want to set more strict data rejection 
thresholds.  
 
6.7 Color and Contour Properties 
 
This section shows how to customize the color, contour level, and contour line properties of the 
graphics.  
 
6.7.1 Color and Contour Properties Window 
 
There are three ways to launch the Color and Contour Properties Window: 1) from the menu, 

View | Color and Contour Properties; 2) by clicking the tool-button ; and 3) from the popup 

menu. When the tool button  is disabled, the custom color and contour are not supported for 
the current view. All graphics start with 16 pseudo-inverted-rainbow colors from blue to red. 
 
There are four columns in the Color and Contour Properties Window. The first column is simply 
the row number and row count. No user interaction is supported for the first column.  
 
The second column shows the contour levels of the current image. These numbers are the actual 
contour level values no matter what scale of contour levels (linear or LOG10) are used. To set 
uniform contour levels with a constant contour interval, click the header “Level” of the second 
column. To change the specific contour level, double-click the corresponding cell. The detail on 
how to set contour levels is discussed in the section of Contour Level Window. 
 
The third column shows the contour line color and thickness (width). All contour lines will have 
the same color and width. The user can not specify the color and width of an individual contour 
line. To change the contour line color and width, click the header “Line” of the third column. 
The detail on how to set contour line color and width is discussed in the section of Contour Line 
Window. 
 
The last column shows the fill colors between contour lines of the current image. To set uniform 
fill colors, click the header “Fill” of the last column. To change the specific fill colors, double-
click the corresponding cell. The detail on how to set fill colors is discussed in the section of 
Contour Fill Window. 
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To insert a new contour level, select the row immediately below the desired new level. For a row 
to be selected, one may click any column of this row. After selecting the row, one may either 
click the Insert button on the window or press the Insert key from the keyboard. A new row will 
be inserted above the selected row. The new level value will be the average of the contour level 
of the selected row and that of the row above. The new fill color will be the same as that of the 
selected row. Then, the user may change the level value and/or fill color by double-clicking the 
corresponding cell. 
 
To delete a contour level, select the desired row and either click the Delete button on the window 
or press the Delete key on the keyboard. 
 
The user may save current color and contour properties as a Surfer level file (*.lvl). This level 
file is fully compatible with Surfer, a graphics package by Golden Software. The user may also 
load any level file into EarthImager. The level file is variable-dependent, that is, a resistivity 
level file may not apply to the data misfit image because the actual contour values are stored in 
the level files. 
 
When the OK button or Apply button is clicked, a level file (*.lvl) is saved in the current 
processing trial folder. This saved level file will be automatically loaded back when the user 
comes back a previously viewed image. That is, EarthImager will memorize custom color and 
contour properties for all different images.  
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6.7.2. Contour Level Window 
 
To launch the Contour Level Window, click the header “Level” of the second column in the 
Color and Contour Properties Window. This helps set uniform contour levels in either a linear or 
logarithmic scale. 
 

 
 
The actual data range is shown at the top of the window. These two numbers are actual data 
minimum and maximum values without taking logarithm if applicable. 
 
The definition of contour levels in EarthImager may be different from commercial graphics 
packages. To plot the data between 0 and 100 at an interval of 20, one should set the Number of 
Colors to 5, and the minimum contour level at 0 and the maximum level at 100. The color scale 
will be shown like this. 

 
 

However, the minimum or the first contour level shown on the Color Contour Window is not 0 
but 20 if a linear scale is chosen. There are actually six (6) contour levels for five colors. 
According to this color scale, any value below 20 will be shown in blue and any value above 80 
will be shown in red, if a linear scale is used. So now the “Min Level” agrees with the minimum 
value on the color scale. This improvement takes effect since the version 1.8.2. 
 
For a logarithmic scale, the labels of color scale will vary. The Interval property in the window is 
a read-only setting and can not be changed. Note that logarithm of 0 and negative values is 
undefined. So be careful when switching from the linear to logarithmic scale. Negative values in 
data misfit and IP data are very common, so the logarithmic scale is disabled when viewing these 
images. 
 
To change a specific contour level value, go to the Color and Contour Properties Window and 
double click the contour level value. This brings up a contour level input box. Type the desired 
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contour level value and click the OK button. The contour levels are automatically sorted in an 
ascending order. 
 

 
 
 

6.7.3. Contour Line Window 
 
To change the contour line color and width, click the header “Line” of the third column in the 
Color and Contour Properties Window. This brings up the Contour Line Window. 
 

 
 
The user may choose any color from the Windows color palette as the contour line color. The 
contour line width is given in pixels. The specified contour line color and width will apply to all 
contour lines. The user can not specify the color and width of an individual contour line. To 
show or hide the contour line, check or uncheck the Show Contour Lines checkbox. New contour 
line color and width will be reflected in the Color and Contour Properties window after the OK 
button is clicked. 
 
Note that contour line color should not be used in the contour fill colors. It is suggested that 
white or black contour line colors be used for color images. For gray scale images, the user has 
more choices of colors for the contour line. 
 
6.7.4. Contour Fill Window 
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To choose a predefined color spectrum as the contour fill colors, click the header “Fill” of the 
last column in the Color and Contour Properties Window. This brings up the Contour Fill 
Window. 
 

 
 
EarthImager has six predefined color spectra. The Current Settings is the color scale of the 
current image and the colors in the Color and Contour Properties Window before the Contour 
Fill Window is launched. Current colors settings may not be any of these predefined color 
spectra. 
 
EarthImager uses Blue-Green-Red color spectrum as the default if no custom color scale is 
specified. The number of colors is specified in the Contour Level Window. 
 
The Begin Color shows the first color in the color spectrum, and the End Color shows the last 
color. These two controls are enabled to accept user interaction when Custom Colors is selected. 
The user may specify a beginning color and an ending color. EarthImager will automatically 
generate blending colors in between. The gray scale is a typical example of two-color blending, 
i.e., blending of black and white colors. 
 
If you could not find and make a desired color scale from this interface, you may use the Color 
and Contour Properties Window to create your own color scale one color at a time. 
 
6.8 Continuous Resistivity Profiler 
 
The Continuous Resistivity Profiler (CRP) module (optional) in EarthImager 2D processes the 
resistivity and IP data collected with a boat-towed array, or a pulled-array, or a roll-along array. 
The primary feature of these types of data sets is a large number of dynamic electrodes, say, tens 
of thousands of electrodes, due to the continuous movement of the array. The processing 
(inversion) of a data file with a large number of electrodes is computer memory demanding and 
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computation-intensive. A marine resistivity survey with a boat-towed array produces thousands 
of measurements with thousands of dynamic electrodes in an hour. It is almost impossible for a 
standard inversion program to process such a large number of data. We developed the 
Continuous Resistivity Profiler (CRP) module to attack this difficult problem.  
 
The CRP module uses our unique Divide-and-Conquer strategy to deal with a large number of 
electrodes. When a data file with a large number of electrodes is loaded, EarthImager divides the 
long section into many subsections and inverts subsections one after another. At the end of the 
inversion, a complete inverted section is assembled and shown in the main window for a 
complete and compressed image and a scrollable window for a detailed view. 
 
The CRP module can invert both resistivity and IP data simultaneously. It can also process a 
large roll-along data file with terrain correction. From the version 1.9.0, the user may choose one 
of three axis label formats: linear distance, longitude/latitude, and UTM coordinates. When the 
mouse cursor hovers on the inverted resistivity image, the location and resistivity value would be 
shown on the bottom status bar. 
 
What makes the CPR module impressive and attractive is that all complicated details of Divide-
and-Conquer are done behind the scene. To a user, inverting a large data set with tens of 
thousands of electrodes is almost the same as inverting our demo Sting Cave data set with 28 
electrodes. A user simply reads the large data set, and then Start Inversion. This simple two-step 
process is very user-friendly. 
 
Here are steps to run the Continuous Resistivity Profiler (CRP) module. 
 
1) Read STG data file.  
 
EarthImager will find out if your data should be processed in the CRP mode. CRP is an optional 
module of EarthImager and it is not included in the basic version of EarthImager. If the number 
of electrodes or dynamic electrode locations in your data is over a threshold, say 200 electrodes 
for marine data, EarthImager would suggest CRP to process your data. If your dongle (hardware 
key) was not activated for CRP, a message dialog shown below will pop up, and your data will 
be inverted in a standard inversion method. This can be painfully slow and the inversion may 
terminate if you have a low computer memory (RAM). The demo CRP data file is CRP.stg, a 
marine data set with over 2000 dynamic electrode locations. The corresponding water depth file 
is CRP.dep. 
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If your data set consists of too many electrodes and your dongle was activated for CRP, 
EarthImager will automatically enter the CRP processing mode. There is a CRP check box on the 
Settings | Initial Settings window for deactivating the CRP mode. If this CRP check box is 
unchecked and you read in a large data file with many electrodes (say, over 200), a dialog box 
would pop up to ask you to confirm: 
 

 
 
After reading a large data file, EarthImager splits the long section into overlapped smaller 
sections and creates a batch inversion process. The user may view the file list by choosing the 
menu item Inversion | Batch Inversion. Deleting any STG file(s) at the end of the spreadsheet is 
allowed at this stage. It is not appropriate to delete any file in the middle of the file list. 
 

       
 
 
2) Read water depth file 
 
An AGI SuperSting marine system collects not only electrical resistivity data, but also water 
depth and water temperature data simultaneously. Our Marine Log Manager (MLM) 
preprocesses these data and outputs an STG resistivity data file and a depth file consisting of 
both water depth and temperature information. Water depth data is read into EarthImager for 
display and implementation of an a-priori model. The temperature data is displayed below the 
inverted resistivity section for comparison and correlation analysis. 
 
Choose the menu File | Read Water Depth File to load a water depth file (*.dep). A complete 
water depth file consists of water depth, average water resistivity and water temperature data. A 
water depth file is usually generated by AGI Marine Log Manager (MLM). Here are the first few 
lines of demo depth file CRP.dep.  
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; DEP File header                                                   // The flag DEP is required 
;First point index=1373 LinearPos=572.9             // Comments starting with ; 
start=47.39076, 14.99161                                      // Latitude and longitude of the first electrode 
;Last point index=2925 LinearPos=1392.8           // Comments starting with ; 
stop=47.38937, 14.98939                                      // Latitude and longitude of the last electrode 
WaterRes=                                                             // Average water resistivity in ohm-m 
unit=meters                                                            // Length or distance unit 
0.0 2.20 19.3                                                // Distance, water depth, temperature in C 
0.4 2.20 19.3 
1.0 2.20 19.3 
 
The water depth file helps (a) draw a white water depth line in the inverted resistivity section, (b) 
set water resistivity as a-priori model, and (c) display a water temperature profile for joint data 
interpretation. 
 
Starting from the version 1.9.0, EarthImager 2D accepts an upgraded water depth file with 5 
columns of data generated by the AGI marine log manager (MLM) version 1.3.3.182 or newer. 
Here are top few lines of a new sample depth file. 
 
; DEP File header 
start=41.61387, -70.42777 
stop=41.61760, -70.42703 
;P1=99 (517.0) 
;P2=195 (967.7) 
WaterRes= 
unit=meters 
// Linear-Distance, Depth, WaterTemp, Lat., Long. 
518.0 2.10 21.8 41.61387 -70.42777 
524.2 2.10 21.8 41.61392 -70.42780 
529.8 2.10 21.8 41.61395 -70.42785 
 
The last two columns are the latitude and longitude of corresponding locations and they are used 
to show longitude/latitude or UTM coordinates on the inverted resistivity section. Without the 
last two columns (Lat./Long.), the inverted section will be shown in the linear distance only. 
 
3) Fix water resistivity 
 
The resistivity of water layer is determined from one of these three approaches. First, if the water 
resistivity is given in the water depth file, the water layer will be set with a single constant 
resistivity value. Second, when the water resistivity value is NOT given in the water depth file, 
apparent resistivity values estimated with closest pairs of transmitting and receiving electrodes 
are used to define the water resistivity. Apparent resistivity values vary along the profile. So this 
approach gives a water layer with varying resistivities. However, this approach will fail if a 
gradient array is used because apparent resistivity values from a gradient array may be greatly 
affected by the water bottom sediments. The last approach to set water resistivity is to input a 
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water conductivity file obtained from water conductivity measurements. Refer to the descriptions 
below for detail. 
 
Three approaches described above help determine the resistivity of water layer, which sets the 
starting model of CRP data inversion. To fix the resistivity of water layer, one must check the 
“Fix Water Resistivity” checkbox on the CRP settings page. If the convergence is not achieved 
in five iterations, the resistivity of water layer is set free for any changes. 
 
4) Read terrain file 
 
For a large roll-along data set with topography, one should read a terrain file (*.trn) after reading 
the STG data file. EarthImager will automatically insert the terrain file into the batch process. 
 
5) Read CRP water conductivity file 
 
If you have a water conductivity meter and take water conductivity measurements while 
collecting resistivity data, the water conductivity measurements may be used to constrain the 
CRP inversion. The top water layer would hold on given water conductivity values without 
changes during the iterative inversion. To read a water conductivity file, go to File | Read CRP 
Water Conductivity File. Here are top few lines of a water conductivity file (*.CON).  
 
;This is a water conductivity file, a comma separated ASCII text file 
;A semicolon starts a command line 
;Offset is the distance between the conductivity meter and first electrode in meters 
Offset=17.0 
;date, time, WaterRes(ohm-m) 
2005-03-04, 18:00:18, 0.315822053 
2005-03-04, 18:00:48, 0.315059762 
2005-03-04, 18:01:18, 0.314602132 
2005-03-04, 18:01:48, 0.315970342 
… 
 
Note that the time stamp (both date and time) in the conductivity file must be synchronized with 
the time stamp in the AGI sting (STG) data file. EarthImager depends on the correct time stamp 
to figure out the measurement location of the conductivity meter. 
 
6) Change inversion settings 
 
Default settings by choosing from the Default Combo Box at the bottom of the Settings Window 
should be a safe option. We hard-coded several sets of default settings for various typical 
scenarios such as Surface, Cross-Borehole ERT, CRP-Freshwater, and CRP-Saltwater. The User 
Settings option in the Default Combo Box corresponds to the settings of the last inversion. Here 
are a few settings of importance of CRP data inversion. 
 

• Minimum Voltage in mV. Marine data signal can be very low. This number must be set 
to below 0.1 mV. 0.02 mV and 0.05 mV would be good options. 
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• Minimum abs(V/I) (ohm). The recommended setting would be 1.0e-05. 
• Min Apparent Res (ohm-m). Seawater resistivity is around 0.25 ohm-m, and fresh 

water resistivity may range from 10 ohm-m to 30 ohm. Therefore, 0.05 ohm-m and 0.1 
ohm-m should be good options for seawater, and 1 ohm-m and 5 ohm-m are good 
settings for fresh water. 

• Number of Mesh Division. Set it to 1 to speed up the inversion. 
• Min Resistivity (ohm-m). This setting is similar to Min Apparent Res. 
• Model Parameter Width. The default is 4. It should be equal to or greater than 2. This is 

a horizontal smoothing factor.  
 
7) Start inversion 
 
Just like doing the standard inversion, click the green arrow tool-button or the Start Inversion 
menu. EarthImager will take care of everything. The inversion will proceed from the left (smaller 
x coordinate) to the right (larger x coordinate) subsection by subsection. The inversion progress 
can be observed from the title caption at the top of the main window. The screen shot below 
shows EarthImager is inverting the second one of total 16 subsections. 
 

 
 
For each subsection, EarthImager saves these six files: an inversion settings file (*.ini), a clean 
STG file after removal of some noisy data, an inversion output file (*.out), a JPG file of inverted 
resistivity section at the iteration with the smallest RMS error, a data file (*.dat) of inverted 
resistivities in the XYZ format, and a blanking file (*.bln) for compatibility with the Surfer 
graphics package. The OUT file may be loaded back into EarthImager for further study. 
 
At the end of CRP inversion, the complete inverted resistivity section is shown in the main 
window in a contracted form, and a long scrollable section is displayed in another window as a 
detailed view. These images are saved in the current trial folder as JPEG files. The inverted data 
is saved in an XYZ format for visualization in other graphics programs. If the longitude and 
latitude data is available in the water depth file, the inverted resistivity data is also saved in an 
LLT (long/lat) file AND a UTM file. An LLT file consists of four columns with the first column 
as the longitude coordinate in degrees, the second column as the latitude coordinate in degrees, 
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the third column as the depth in meters or feet, and the last column as the inverted resistivity 
value in ohm-m. The first two columns of a UTM file are Easting (X) and Northing (Y) in 
meters. 
 
8) View results 
 
The Scrollable Image Viewer is proportionally scaled from the main window. To change the size 
and aspect ratio of the scrollable image, you should resize the main window first, then click the 
Refresh button on the Scrollable Image Viewer or choose the menu View | Continuous 
Resistivity Profile. The Scrollable Imager Viewer is a passive viewer and the image in the viewer 
is not editable and not modifiable. It would reflect the changes in the main window 
instantaneously. If not, you should click the Refresh button. The Print button prints out a long 
inverted section on several pages of paper in screen resolution. 
 
The user can choose one of three axis label formats from the last tool button (Lat/Long) on the 
top toolbar. The three options include linear distance in meters or feet, longitude/latitude, and 
UTM coordinates in meters. The image below shows the longitude/latitude format. In addition, 
the location data is also shown on the bottom status bar when the mouse cursor moves on the 
inverted resistivity section. 
 

 
 
8) Save image 
 
The image for each subsection at the iteration with the smallest RMS is saved automatically. 
There are two combined and complete inverted sections: one is the compressed short image on 
the main window and another long scrollable image is shown on another image viewer. Both 
short and long inverted sections are saved as JPG files automatically at the end of inversion. 
However, combined and complete inverted IP sections are NOT saved automatically. You have 
to go to View | Continuous Resistivity Profiler | CRP Inverted IP Section to display and save 
these images. 
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If you change any graphical settings, you have to save the new updated image by yourself. To 
save the short image, go to File | Save Image or click the tool button with a blue disk image. To 
save the long image, click the Save Image button on the CRP long section viewer.  
 
9) Print 
 
The Print button on the window below prints the inverted resistivity section on many sheets of 
paper. You should paste them together with glue or tapes. 
 

 
 

 
 
 
10) View  histogram 
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A data misfit histogram is assembled from all subsections for removal of poorly-fit data. After 
noisy data removal from the histogram, the CRP data inversion may be restarted. 
 
11) Restart CRP data inversion 
 
CRP data inversion may be restarted after adjustment of some settings. At the end of CRP data 
inversion, the user may go the histogram for removal of poorly-fit data or go to the Settings 
windows to change some settings. Then restart the CRP inversion. 
 
6.9 Underwater resistivity surveys 
 
Underwater resistivity surveys have some or all electrodes placed under the water. Continuous 
resistivity profiling (CRP) described in the last section has all electrodes floating on the water 
and pulled behind a boat. Underwater resistivity surveys consist of five typical cases. In the first 
case, the bottom sediments have a flat surface. All electrodes are placed on a horizontal line at 
the same elevation. The second case is more complicated with an uneven bottom. So the terrain 
correction is required. The most complicated third case consists of mixed on-land and 
underwater electrodes. Cases 4 and 5 are two special cases of Case 3 and they are most common 
scenarios in the field. 
 
Both a command file and an STG file for an underwater resistivity survey assume that electrodes 
are placed on a flat ground surface. The X coordinates of the electrode geometry are defined by a 
tape measure or cable length and Y are set to 0 for all electrodes. In an UWT file, any line with a 
leading ‘;’ is a comment line and is ignored by the EarthImager. These assumptions apply to all 
five cases. 
 
6.9.1 Underwater electrodes on a flat water bottom 
 
This is the case number 1 of underwater resistivity surveys. All electrodes are under the water 
but on a flat water bottom. To invert underwater resistivity data, we need an STG data file and an 
underwater terrain (UWT) file. As stated above, the electrode geometry in the STG file is based 
on the assumption of a flat ground surface. The UWT file describes the bottom terrain and water 
depth. Here is a sample UWT file of Case 1 (Amistad1.uwt). 
 

 

Case 1 – Underwater with a flat bottom

 
;Sample underwater terrain file (*.UWT) 
;Any line started with ';' is a comment line  
;Distance unit in meters or feet 
unit=meters 
;case flag: underwater survey cases. 
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; 1 - Underwater without terrain, 
; 2 - underwater w/ terrain 
; 3 - mixed surface and underwater electrodes w/ terrain 
1 
;Water resistivity. If unknown, leave it blank 
WaterRes=65 
; Case 1: X below is the horizontal distance 
; X, Water Depth 
0, 12 
 
In an UWT file, any line with a leading ‘;’ is a comment line and is ignored by the EarthImager. 
The first valid line defines the distance unit: unit=meters. This is followed by the case number of 
underwater surveys. In this case, it is the Case #1. Next, the water resistivity is given in ohm-m. 
If no water resistivity is available, leave this line as “WaterRes=”. The last section describes the 
water depth. Because the water bottom is flat, we need a single water depth measurement only to 
define the water layer. Note that the depth value is positive. 
 
To invert the underwater resistivity data, follow these simple steps: 
 

1) Read an STG data file. 
2) Change inversion settings if applicable. For a survey along an ocean coast, choose the 

default “Conductive Earth” setting. This step is optional. 
3) Read “Underwater Terrain File” from the File menu. 
4) Start Inversion. At the end of inversion, one may use the histogram to remove noisy data 

and run the inversion again. 
 
6.9.2 Underwater electrodes on an uneven water bottom 
 
This is the Case 2 of underwater resistivity surveys. All electrodes are under the water and on an 
uneven water bottom. Here is a sample UWT file of Case 2 (Amistad2.uwt). 
 

 

Case 2 – Underwater with an uneven bottom

 
;Sample underwater terrain file (*.UWT) 
;Any line started with ';' is a comment line  
;Distance unit in meters or feet 
unit=meters 
;case flag: underwater survey cases. 
; 1 - Underwater without terrain, 
; 2 - underwater w/ terrain 
; 3 - mixed surface and underwater electrodes w/ terrain 
2 
;Water resistivity. If unknown, leave it blank 
WaterRes= 
; Case 2: X below is the horizontal distance 
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; X, Water Depth 
0, 15 
21, 14 
33, 13 
51, 12 
83, 12 
102, 11 
120, 10 
140, 11 
155, 15 
169, 20 
180, 16 
191, 14 
197, 15 
205, 17 
218, 15 
246, 14 
268, 12 
282, 13 
 
All X coordinates of water depth measurements are relative to the X coordinate of the first 
electrode. So it is critical to have a unified coordinate system. The X coordinates of the water 
depth section in an UWT file are the horizontal distance because the underwater electrode cables 
are usually not visible. The water depth value is always positive. It is preferred that the range of 
water depth measurements extends beyond both ends of the underwater cable.  
 
A terrain correction is involved in Case 2 due to an uneven water bottom. The water layer above 
the electrodes is constrained to the water resistivity if known. The data processing steps are the 
same as those in Case 1.  
 
6.9.3 Mixed on-land and underwater electrodes 
 
This is the Case 3 of underwater resistivity surveys. Some of electrodes are on the ground 
surface and others are under the water. This happens when the survey line across streams or 
rives. Each water body is considered as a water segment on a survey line. Two or more water 
segments are allowed in an inversion. Here is a sample UWT file of Case 3. 
 

 

Water Segment #1 #2

 

218197 182 153 
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;Sample underwater terrain file (*.UWT) 
;Any line started with ';' is a comment line  
;Distance unit in meters or feet 
unit=meters 
;case flag: underwater survey cases. 
; 1 - Underwater without terrain, 
; 2 - underwater w/ terrain 
; 3 - mixed surface and underwater electrodes w/ terrain 
3 
;Water resistivity. If unknown, leave it blank 
WaterRes=65 
; Case 3: X below is the cable length or tape measure 
; X, Elevation of ground Surface 
0, 97 
21, 98 
33, 99 
51, 100 
83, 100 
102, 101 
120, 102 
140, 102 
153, 98       ; Start of water segment 1 
182, 98       ; End of water segment 1 
191, 100 
197, 99       ; Start of water segment 2 
218, 99       ; End of water segment 2 
246, 101 
268, 99 
282, 98 
 
:Water Segment #1 
;StartX, EndX. Must be in the elevatoin data above 
153, 182 
; 0-based horizontal X,  Water Dep 
0.0, 0.0 
3.0, 2.5 
6.8, 4.0 
10.0, 5.5 
14.0, 5.0 
21.6, 3.2 
24.0, 1.8 
26.1, 0.0 
 
:Water Segment #2 
;StartX, EndX. Must be in the elevatoin data above 
197, 218 
; 0-based horizontal X,  Water Dep 
0.0, 0.0 
3.1, 1.5 
5.9, 2.3 
9.4, 3.5 
11.3, 3.2 
13.0, 2.7 
16.5, 2.1 
18.2, 1.2 
19.4, 0.0 
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As usual, the distance unit, case number and water resistivity are required input fields. In 
addition, this underwater terrain file consists of both the terrain elevation of the ground surface 
and the water depth of water segments. 
 
In the terrain elevation section, X coordinates are given in the tape measure or cable length. You 
do not have to measure the elevation at the electrode location. The goal of terrain survey is that 
the terrain elevation curve fits the ground topography fairly well. There is no limit on number of 
elevation measurements and location of measurements. However, the starting and ending 
locations of each water segment must appear in the terrain elevation section of an UWT file of 
the Case 3. It is also a common sense that the elevations at both ends of a water segment are the 
same. 
 
One or more water segments may appear in an UWT file of Case 3. “:Water” flags both the 
beginning a water segment and the end of the last water segment. The following two numbers in 
one line after the flag are the starting and ending X coordinates in the tape measure. These two 
numbers must agree with two X coordinates in the terrain elevation section. The water depth 
measurements are given in a local coordinate system of each water segment. It should always 
start with (0.0, 0.0). That is, at the beginning of each segment X = 0 and Water-Depth = 0. It is 
obvious that at the end of a segment X = segment-width and Water-Depth = 0. In this local 
segment coordinate system, X coordinates are the horizontal distance. 
 
6.9.4 Mixed land and underwater electrodes with a water body at the end 
 
This is the Case 4, one of most common scenarios in the field. Case 4 is a variant of Case 3 with 
one open-ended water segment. We added this case for ease of construction of an underwater 
water terrain file.  

Case 4 – Mixed land and underwater

 
 

Open ending

Here is an sample underwater terrain file of Case 4: beach.uwt. 
 
; Data Courtesy of Jason Greenwood and Peter Swarzenski of the USGS, St Petersburg, Florida  
unit=meters 
; Case 4 - mixed land and underwater electrodes with a water body at the end 
4 
WaterRes=0.25 
; X below is the cable length or tape measure 
; X, Elevation of Land Surface 
0, 2 
5, 1 
10, 0.5 
19, 0.1 
20, 0 
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:Water Segment #1 
; 0-based horizontal X,  Water Depth 
0, 0 
20, 0.2 
30, 0.5 
40, 0.9 
50, 1.0 
60, 1.1 
70, 1.2 
80, 1.3 
90, 1.4 
110, 1.5 
 
The first section of this UWT file describes the elevation of land surface from 0 to 20 meters. 
The X coordinates are defined by tape measure or slope distance. The water edge is at X = 20m. 
The water segment has water depth measurements from 0 to 110m. Note that a water segment 
has its own local coordinate system with X = 0 at the water edge. Therefore the x value is the 
distance from the shore. Here is the processing result of a data set offered by Jason Greenwood 
and Peter Swarzenski of the USGS, St Petersburg, Florida. In this case, part of the cable was laid 
out on the beach and the rest of the cable was in the ocean water with a resistivity value of 0.25 
Ohm-m. The objective of this survey was to study the interaction between fresh water and 
saltwater along a coastal area. 
 

 

beach.stFreshwater g

Fine quartz sand

Freshwater Spring?Limestone

2D Underwater Resistivity Imaging: an offshore zone of freshwater discharge 
 
 
6.9.5 Mixed land and underwater electrodes with a water body at the beginning 
 
This is the Case 5, another common scenario in the field. Case 5 is also a variant of Case 3 with 
one open-ended water segment at the beginning of a profile. This case is singled out because it 
requires a slightly different handling. 
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Case 5 – Mixed land and underwater

 

 Positive X  

X = 0 

 
Here is a sample underwater terrain file of Case 5: BeaverHole.uwt. 
 
;Data Courtesy of Dave Welch, Neil O Anderson & Associates, Sacramento, California 
unit=Meters 
;Case 5 = Water segment at the beginning of the profile 
5 
WaterRes=71.4 
39,         0 
41.85,   0.93 
44.5,    2.34 
47.5,    2.34 
50.5,    2.34 
53.39,  1.51 
56.35,  1.04 
59.25,  0.26 
62.13,  -0.56 
65.08,  -1.09 
68.06,  -1.5 
71.03,  -1.87 
74.03,  -2.03 
77.03,  -2.18 
80.01,  -2.5 
82.99,  -2.86 
85.98,-2.97 
91.98,-2.97 
109.98,-2.97 
127.98,-2.97 
 
:Water Segment #1 
; 0-based horizontal X = distance from the shore, Water Depth 
0, 0 
4.4, 0.61 
8.8, 1.22 
13.2, 1.83 
17.6, 2.29 
22, 2.74 
24.83, 3.2 
27.67, 3.66 
30.5, 4.12 
33.33, 4.57 
36.17, 6.1 
39,        7.62 
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The topography of dry land is defined in the same way as Case 4. However, the orientation of x-
axis for the water segment is opposite to that of land topography (see the figure above). The 
coordinate x is the distance from the shore, same as the Case 4.  

 
This data set (BeaverHoles.stg) was offered by Dave Welch, Neil O Anderson & Associates at 
Sacramento, California for investigation of beaver holes and voids in an earth dam. The 
underwater electrodes are at the beginning of the profile.  
 
6.10 Execution of EarthImager from a Script 
 
EarthImager 2D may be invoked from a script or from a Windows Command Prompt for 
automation of data processing. EarthImager 2D supports three different scenarios: inversion of a 
single data set, inversion of multiple data sets and time lapse inversion. To process a single data 
set, one uses the data file name as the command line argument like this: 
 
EarthImager2D <DataFile> 
 
In this case, the processing result is saved in an inversion output (OUT) file. But no image or 
inverted model in XYZ format is saved. Note that the file path is required for both 
EarthImager2D.exe and data file. If a path name or file name consists of any space, it must be 
quoted. Here is an example: 
 
EarthImager2D “C:\Program Files\AGI\EarthImager2D\demo\Amistad.stg” 
 
To process multiple data sets or to run time lapse inversion in a batch mode, a batch file which is 
the same as the one in Section 6.6 is needed. The script syntax in this case is: 
 
EarthImager2D <BatchFile> 
 
If the first file at the top of a batch file is an inversion output (OUT) file, the time lapse inversion 
is carried out. In the batch mode, a log file is saved to keep track of the inversion process and 
here is a sample log file. 
 
Start Time: 9/19/2008 3:23:30 PM 
OUT File: C:\Engineering\Projects\pc\EarthImager2D\Demodata\TimeLapse0\trial1\TimeLapse0_trial1.out 
Current Time: 3:23:30 PM 
Data File: C:\Engineering\Projects\pc\EarthImager2D\Demodata\TimeLapse1.stg 
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Current Time: 3:23:32 PM 
Data File: C:\Engineering\Projects\pc\EarthImager2D\Demodata\TimeLapse2.stg 
Current Time: 3:23:34 PM 
Data File: C:\Engineering\Projects\pc\EarthImager2D\Demodata\TimeLapse3.stg 
End Time: 9/19/2008 3:23:36 PM 
 
In the time lapse mode, difference image and difference model in xyz format are saved, but no 
AVI file is saved. 
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7. TOOLS 

 
7.1 Two-Dimensional Command Creator 
 
This two-dimensional (2D) command creator creates command files for AGI Sting R1, 
SuperSting R1, and R8 instruments for 2D resistivity imaging. This 2D command creator 
supports Pole-Pole, Pole-Dipole, Dipole-Dipole, Bipole-Bipole, Edge Gradient, Wenner-
Schlumberger, Dipole-Gradient, PowerSting and Strong Gradient arrays. The bipole-bipole array 
is not applicable to the surface surveys.  This command creator is not supposed to replace the 
command creator in the AGI SuperSting Administrator. The unique features of this command 
creator include the command optimization based on the predicted signal strength and numerical 
modeling, command simulation, bipole-bipole array, various gradient arrays, PowerSting array, 
and survey time estimate. 
 

 
 
The left part of the command creator shows the layout of electrodes. On the right there are five 
tabbed pages. The Geometry page shows the electrode address and coordinates in a spreadsheet. 
The Borehole page provides a GUI to input borehole electrode geometry. The Surface page 
provides an interface to input surface electrode geometry. On the Settings page, the user can 
choose the instrument type, array type, and signal strength. The Simulation page sets the 
electrode symbol size in the figure to the left and simulation speed and it also helps estimate the 
field survey time. 
 
7.1.1 Electrode geometry 
 
The electrode geometry defines the location of electrodes and it is required to visualize the 
electrode configuration, to show the simulation of commands, and to estimate the signal strength 
for an effective command file. A geometry file consists of several comment lines at the 
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beginning of the file, a line showing the length unit, and electrode coordinates. Here are first few 
lines of a sample 2D geometry file. 
 
; 2D Electrode Geometry File 
; Distance unit in meters by default 
; This is a comma separated text file 
; Z coordinates are negative below the surface 
; Addrress, X, Z 
1, 0, 0 
2, 2, 0 
3, 4, 0 
4, 6, 0 
5, 8, 0 
6, 0, -1 
7, 0, -2 
8, 0, -3 
9, 0, -4 
10, 0, -5 
11, 0, -6 
12, 0, -7 
13, 0, -8 
… 
 
Note that any line starting with a semicolon “;” is a comment line.  A comment line may be 
placed anywhere in the file. The length unit is assumed to be meters. A geometry file may be 
created in any ASCII text editor such as the NotePad. 
 
The electrode geometry consists of three columns that are comma-separated. The first column is 
the electrode address that must start from 1 and end with the number of electrodes. Note that the 
Z coordinate is zero (0) on the ground surface and negative downward. No remote (infinite) 
electrode is supported.  
 
Once the electrode geometry file is loaded into the command creator, the spreadsheet on the 
Geometry page displays the electrode address and two-dimensional coordinates.  
 
The remote electrodes for the pole-pole array and the pole-dipole array are NOT required in the 
geometry file. Their coordinates are estimated by the command creator. In a Sting R1 command 
file, the electrode address 253 indicates the remote current electrode and the address 254 
represents the remote potential electrode.  
 
There are two ways to input electrode geometry. First, input the electrode geometry from a 
geometry (*.geo) file or a command (*.cmd) file by clicking the Load Geometry button. To 
switch between the geometry files and command files, change the Files of Type on the Open File 
Dialog. Second, add one borehole at a time using the controls on the Borehole page when the 
electrode spacing is constant, or add surface electrodes at a constant spacing on the Surface page. 

 Page 118 of 140



Instruction Manual of AGI EarthImager 2D, 2014-11-24 

The electrode coordinates are not editable. The geometry in the spreadsheet may be saved for 
later use. By the way, a geometry file may be created in any text editor such as the NotePad. 
 
We suggest that the user set electrode addresses in a sequential order without any gap, starting 
from one (1). This arrangement is subject to change. 
  
Map electrode addresses in the command file into the physical addresses (the pin numbers of 
connectors) using the Address Table in the SuperSting. This step is critical. TAny negligence of 
this step is fatalT to the usability of data.  
 

              
 

7.1.2 Array type 
 
This 2D command creator is not intended to create all regular or standard electrode arrays that 
can be found in AGI Sting/SuperSting Administrator. Instead, we offer these nine arrays: pole-
pole, pole-dipole, dipole-dipole, bipole-bipole, edge gradient, Wenner-Schlumberger, dipole-
gradient, PowerSting and strong gradient arrays. 
 
A mixed array with a combination of two or more array types is supposed to produce a better 
resolution. The cost is a longer data collection time in the field and a slightly longer data 
processing time depending on the number of data points and computer speed and memory size. 
 
In a bipole-bipole array, two transmitting electrodes are separated in two different boreholes, and 
two receiving electrodes are also placed in two different boreholes, so high signal strength is 
expected. It is strongly recommended that electrodes in all boreholes are numbered in the same 
orientation, that is, either from the top to the bottom or from the bottom to the top.  
 
The dipole-dipole array here is not a standard/conventional dipole-dipole array. It is a mixed 
array with a combination of standard dipole-dipole array with n = 1 ~ 6, and nonstandard dipole-
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dipole array with AB ≠ MN (Stummer et al, 2004).  The Wenner-Schlumberger array is a 
combination of the Wenner and Schlumberger arrays and more.  
 
Our Edge Gradient array would have an improved resolution at two edges of a profile because all 
measurements are associated with either first or the last electrode on the profile. This gradient 
array generates a large number of measurements. An effective way to reduce the number of data 
points is to reduce number of current injection points by setting A/B Skip on the Setting tab. A/B 
Skip = 0 indicates never skipping any electrode. A/B Skip = 1 leads to current injection at every 
other electrode.  
 
Strong Gradient array produces strong signal and it is recommended for a large number of 
electrodes to reduce number of measurements and for conductive environment such as on the 
seafloor to enhance measured signal. A multiple of eight measurements are always taken 
between two transmitting electrodes. “Skip Electrodes” sets the minimum distance between 
transmitting and receiving electrodes to avoid receiver overflow and reduce noises. “TX 
Overlap” controls data density. 
 
The depth of data points on a pseudosection for a gradient array was changed since Version 
2.4.0. The previous versions set the depth based on the AB distance only, which gives a 
misleading pseudosection. Since Version 2.4.0, the depth is estimated from all four electrode 
locations. 
 
A mixed dipole-gradient array is a combination of a dipole-dipole array and a gradient array. The 
dipole-dipole array has n = 1 to 8 with three dipole lengths (1 to 3) to cover the near surface. The 
gradient array is exactly the same as the standalone gradient array in this command creator.  
 
Pole-pole or pole-dipole array is used for large penetration depth. The remote electrode 
coordinates in the Sting command file are simply a rough estimate by the command creator. True 
coordinates of the remote electrodes should be used to replace the estimate. The coordinate of the 
remote electrodes for SuperSting are inputted into the instrument in the field. 
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PowerSting array was added to support AGI high-power PowerSting transmitter with which the 
transmitting electrodes must be switched manually. “PowerSting TX” lists all transmitting 
electrode pairs which can be generated automatically after setting number of transmitting 
locations (NumElec). PowerSting TX may also be typed in manually. However, this PowerSting 
array is applicable only if the transmitting electrodes take up the receiving electrode addresses. 
Ideally, PowerSting command file should be created manually to deal with the flexibility of 
transmitting electrode layout. 
 
Checking the Reciprocal box would produce the reciprocal commands only. No forward 
commands are created. For combined forward and reciprocal commands in one file, one must 
copy and paste two files together.  
 
7.1.3 Signal strength and numerical check 
 
Data with low signal strength is relatively noisier due to the low signal-to-noisy ratio and is 
usually hard to fit in the inversion process. Therefore it is preferred not to collect data with small 
signal strength. In the 2D command creator, we estimate the signal strength for each 
measurement command based on a homogenous half-space model with parameters set by the 
user. Any command that produces a signal lower than a hard-coded threshold of signal strength 
would be rejected and not included in the command file. Average resistivity is the estimated 
average resistivity of the survey site. The injection current is the lowest current intensity the 
transmitter can inject into the ground of your specific survey site. Average resistivity and 
injection current are completely empirical estimates. To be conservative, set a low average 
resistivity value, say 20 ohm-m, and a low current, say 100 mA.  
 
For cross borehole resistivity tomography, a low current injection plus a low background 
resistivity leads to a low measurement signal strength that is excluded from the command file. 
This produces a command file without cross-hole measurements. To increase number of cross-
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hole measurements, raise both background resistivity and current injection. We suggest that you 
run the simulation to examine the command file. This signal strength check  
 
The numerical error comes from the numerical algorithm for solving the partial differential 
equation because a discrete mathematical method is used to solve a continuous problem. 
Numerical errors vary from data to data. A data point associated with a large numerical error is 
usually hard to fit in the inversion and produces artifacts in the recovered resistivity model. So it 
is important to remove those command lines associated with a large numerical error. The 
generated command file will always go through the forward modeling process to identify data 
points with a high numerical error, which are then removed. It is important that the inversion 
settings for both command creation and data inversion must be the same in order to make this 
numerical check effective.  
 
We also offer two more settings to control the size of a created command file. The first one is to 
set a maximum number of measurements. The default number equals  
 
NumElectrodes * (NumElectrodes-1) / 2, 
 
which corresponds the maximum number of measurements one can obtain with the pole-pole 
array. The second setting is how much time one has in the field. The number of measurements is 
estimated based the given survey time, instrument type, and instrument settings on the 
Simulation page. 
 
 
7.1.4 Create a command file 
 
Here are steps to create a command file. 
 

1) Launch EarthImager 2D. 
2) Select 2D Command Creator from the Tools menu. 
3) Load an electrode geometry file or a command file, or input electrode address, 

coordinates manually. The Surface page or Borehole page can be very useful for 
regularly spaced electrodes. Note that Z = 0 at the ground surface, and Z is negative 
in the ground. 

4) After adding electrodes manually, click the Sort button to sort the electrode address in 
a sequential ascending order. One can also achieve this using the popup menu. 

5) Choose an Instrument Type. 
6) Choose an Array Type. 
7) Decide the forward or reciprocal command files. To create a combined forward and 

reciprocal command file, one has to create two separate command files first and then 
merge them in a text editor such as the NotePad. 

8) Set the signal strength controls: average resistivity value, and injection current. 
9) Set maximum number of measurements and/or max survey time. Remember to check 

the box in front of text setting to enable your choice. 
10) Click the Create button to create measurement commands. 
11) Save the command file. 
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12) Change electrode symbol size or command simulation speed using a popup menu in 
the image area. 

13) Click the Start Simulation button to view how data are collected. 
14) Stop the simulation any time by clicking the Stop Simulation button. 
15) Click the Step button for manual command stepping.  
16) Check the Survey Time field for the estimated survey time with existing command 

file. Note that the survey time depends on the instrument type, number of cycles, 
cycle time, and measurement of IP data. 

 
7.1.5 Reverse array and reciprocal array 
 
Reverse array and reciprocal array are somewhat similar but they are not exactly the same. A 
reverse array basically starts the measurements from the end of line without altering the array 
type to save some time in a roll along survey. However, a reciprocal array or command file 
switches the transmitter and receiver for a pair of forward and reciprocal measurements to check 
data quality.  
 
For symmetric arrays such as the pole-pole array and the standard dipole-dipole array with 
AB=MN, reverse and reciprocal arrays are identical. An excellent example to demonstrate the 
difference between a reverse array and reciprocal array is the pole-dipole array. In this case, a 
reverse array of the pole-dipole array will still be a pole-dipole array with B at infinity. However, 
a reciprocal array should set N at infinity and ends up with a dipole-pole array. This command 
creator never creates a single command file with both forward and reverse/reciprocal arrays. One 
must create forward and reverse/reciprocal arrays separately and then merge them together. 
 
7.2 Check Memory 
 
This tool checks total and available memory sizes and estimates the maximum number of 
electrodes and data allowed in the inversion. The estimates are a rough guideline. If the actual 
number of electrodes is smaller than the estimated number of electrodes, your computer may be 
able to accommodate more data than the estimated number of data.  
 
To check the memory status, choose the menu item Check Memory under the Tools menu. You 
may observe that the available physical memory is usually smaller than the total memory 
(RAM). The Windows XP operating system alone may take about 120MB. If your computer has 
only 128MB RAM and runs the Windows XP operating system, you can hardly run any 
application. We suggest that you run “Check Memory” immediately after the installation of 
EarthImager, so you will have a rough idea how many electrodes and data points your computer 
can handle. 
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Note that the estimated numbers may vary depending on how many application programs are 
running while you Check Memory. 
 
7.3 Transform Electrode Coordinates 
 
The electrode coordinates in the command file sometimes are incorrect or need to be mapped 
from a local coordinate system to a global coordinate system such as UTM. The inappropriate 
electrode coordinates are passed down to the STG data file. It is almost impossible to edit the 
electrode coordinates manually in an STG data file due to the nature of the STG data format. 
This utility reads in a resistivity data file such as an STG file, sorts and lists all existing 
electrodes. The user is given three options to input new electrode geometry: reading a geometry 
file, or inputting all new coordinates from the keyboard, or typing the beginning and ending 
coordinates and then interpolating geometry. Once the new electrode geometry is defined 
without any blank cells, a transformed STG data file with new electrode geometry may be saved. 
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To start the “Transform Electrode Coordinates” utility, choose the menu item Tools | Transform 
Electrode Coordinates. There are two links on the window for scaling all coordinates with a 
constant factor (go to Scale Distance) and for Shifting and Reversing a profile (go to Shift and 
Reverse). You may also find these two tools under the Edit menu. 
 
To transform coordinates in a more complicated way, follow these steps. 
 

1) Read a data file in either STG or DAT or URF format by clicking the button Read Data 
File or using the same popup menu item. The electrode ID and coordinates will be listed 
to the left of the spreadsheet. 

2) Input new electrode coordinates. This can be done in three different ways. First, type in 
all new coordinates manually from the keyboard. Second, type the coordinates for the 
first and last electrodes and then click the button “Interpolate Geometry”. This option 
assumes all electrodes are equally spaced on a straight line. “Interpolate Geometry” also 
works on a segment-by-segment basis if there is a constant electrode spacing in each 
segment. For each segment, the coordinates of beginning and ending electrodes are 
required. Third and the last, read in an electrode geometry file which is a three-column 
and comma-separated ASCII text file and is the same as the geometry file for the 2D 
command creator. Here is an example. 

 
;Electrode geometry file created by AGI EarthImager 2D. Version: 1.8.5 (Build 331) 
;Distance unit is meters. 
;ElecID, X, Y 
1, 0, 0 
2, 2, 0 
3, 4, 0 
4, 6, 0 
5, 8, 0 
6, 0, -1 

 Page 125 of 140



Instruction Manual of AGI EarthImager 2D, 2014-11-24 

7, 0, -2 
8, 0, -3 
9, 0, -4 
10, 0, -5 

 
3) To simply reverse the profile, click the button “Reverse the Profile”. 
4) To reset the new coordinates, click the button “Reset Geometry”. 
5) Save new electrode geometry in a file. 
6) Save the STG data file with the new electrode coordinates in a 2D (X, Y) format. 

 
Coordinate transform sometimes involves rotation of the coordinate system. This results in an 
STG data file with varying X and varying Y coordinates for a surface data set though all 
electrodes are strictly on a straight line. To process this type of data set, it is required to set 
Definition of Y Axis = Line Offset on the Initial Settings Window. 
 
7.4 Create AVI Movie 
 
This utility creates an AVI movie file with sound from multiple time-lapse bitmap images and a 
WAV sound file. A simple AVI player is also provided.  
 

 
 
To create an AVI movie file, please follow these steps. 
 

1) Add multiple bitmaps files. One or two frames would not produce any decent animation. 
Three or more frames are required. There are two approaches to add bitmap files to the 
list. First, one may load a batch file with a list of bitmap file names and file path. Second, 
click the button “Add Bitmap Files” to choose multiple bitmap files from Windows File 
Open Dialog. Note that image files other than bitmap files are not a valid input. 

2) Arrange the bitmap files in a temporal sequential order by using the up and/or the down 
arrow button. To delete any bitmap file, press the Delete key on the keyboard. 
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3) Add a WAV sound file if any. It would be difficult to synchronize the length of a sound 
file to the duration of bitmap sequence. 

4) Set the time interval between two neighboring frames. 
5) Click the Create AVI button to create an AVI animation file. If successful, the new AVI 

movie would be played in the built-in AVI player.  
6) Save the bitmap file list and the WAV sound file to a batch file in the ASCII text format. 

This batch file may be loaded back into the AVI movie maker. 
 
To play an AVI movie, simply open an AVI file and then click the green universal play button. 
During the time lapse inversion, a bitmap file showing resistivity or conductivity changes for 
each monitor data file is created and added to the bitmap file list. At the end of time lapse 
inversion, an AVI file is created and played automatically in the media player. 
 
7.5 Merge Data Files 
 
This feature is designed for combining two or more data sets collected with different arrays into 
a single file, so mixed array data set can be inverted together for improved resolution.  
 
You may have a data file collected with the dipole-dipole array, another data set collected with 
the Wenner array at the same location. You can combine these two data sets into one file with 
this utility.  
 
You can merge AGI STG data files only. The STG data files to be merged must be in the same 
2D or 3D format. This utility simply copies and pastes two files together. 
 

 
 
 
7.6 Merge SuperSting Command Files 
 
This tool combines several single-array command files into one mixed-array command file, so a 
data set with a mixed array may be collected and processed (inverted) at once. The command 
files to be merged must:  
 

1) have the same instrument type such as SuperSting R1 or SuperSting R8,  
2) have the same electrode geometry format such as (x, y) or (x, y, z), 
3) be in any four-electrode array such as dip-dip, Wenner, Schlumberger or gradient, 
4) have the same number of electrodes and same electrode layout,  
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5) have the same length unit,  
6) not be a Sting command file, and 
7) not be in a pole-pole or a pole-dipole array. 

 

 
 
To merge several SuperSting command files, simply add command files to be merged to the List 
of Command Files by clicking the Add Command Files button. The up and down arrow buttons 
may be used to move a command file up or down on the list. The order of command files will 
determine the data collection sequence during the actual survey in the field. Finally, click the 
Merge button to save a mixed array command file. 
 
7.7 XYZ to UTM  
 
This utility converts the inverted resistivity data in the XYZ format into an ASCII text file with 
the UTM or Lat/Long coordinates. The original surface linear coordinates (X) are converted into 
UTM or Lat/Long coordinates. The negative depth value, equivalent to the elevation, may be 
converted into positive depth values by flipping the axis orientation. The original XYZ file 
consists of three columns: X, negative depth (elevation), and resistivity. The converted file has 
six columns:  
 

1) UTM-X (easting) or Decimal Longitude,  
2) UTM-Y (northing) or Decimal Latitude,  
3) Elevation if positive upward or Depth if Positive Downward 
4) Resistivity in Ohm-m 
5) Depth (positive) 
6) Linear distance from the starting point of the profile defined by Starting X(m) 

 
To launch the XYZ to UTM utility, go to the menu Tools | XYZ to UTM. The GUI interface 
would show up as below. The conversion process proceeds as follows. 
 

1) Start EarthImager 2D and go to the menu Tools | XYZ to UTM. 
2) Open an ASCII text file with three column data: X, elevation or depth, and resistivity. 

This is typically an inverted resistivity file in the XYZ format saved after the inversion. 
Coordinate bounds, the minimum and maximum of X and depth, in the original XYZ file 
are shown at the top of the window. These fields are read-only. 
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3) Input UTM or decimal Lat/Long coordinates of the beginning and ending points. Set the 
beginning point to either original minimum X or maximum X location, which would help 
reverse the profile if needed. Notice that the profile length calculated from UTM or 
Lat/Long coordinates may be different form the profile length in the original data file. 
The length error is reported at the bottom of the window.  

 

 
 

4) In an EarthImager XYZ data file, we assume that the vertical (Y or Z) axis is positive 
upward with zero at the ground surface. In other word, the vertical axis shows the 
elevation. Any positive Z coordinate would end up in the air. If one needs the converted 
UTM or Lat/Long file to show the depth, check the Positive Downward box. The 
difference between Min Z and Max Z is ensured to agree with the original data. 

5) Click the Convert button to convert XYZ to UTM and save the converted UTM or 
Lat/Long file. Note that the length error is reported at the bottom of the window. If the 
error is over 5%, an error message will pop up as a reminder. If the error is over 50%, the 
user is prompted to correct the UTM or Lat/Long inputs. 

 
For a 2D survey along a crooked line or piecewise straight line, the data may be inverted in 
EarthImager 2D as far as the entire line is nearly straight. An additional feature at the bottom of 
this utility helps convert inverted resistivity data in an XYZ format into a UTM format with an 
assumption of a piecewise straight line. There are two input files in this case. The first file is the 
standard inverted resistivity data in an XYZ format. The second file is called an Anchor Points 
file with coordinates of starting point, turning points and ending point. The anchor points file is a 
three-column comma-separated ASCII text file Here is a sample anchor points file consists of 
three straight line sections with four anchor points: 
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; x, utm-x, utm-y 
0, 621233.439, 4334519.823 
91.44, 621143.387, 4334504.652 
182.88, 621052.898, 4334492.616 
252.3754, 620985.33, 4334476.549 
 
The conversion starts by opening an XYZ file, then opening an anchor points file, and finally 
clicking the Transform button. 
 
7.8 Extract Sub Dataset  
 
This utility is used to extract a sub data set from a long profile so that one can zoom in the 
specific location for fine details. To start, choose the menu Tools | Extract Sub Dataset. Then 
click the button Read Data to load a raw data file. You should see something similar to the left 
screen shot below. The sample data has 56 electrodes and 424 data points. Say, you want to 
extract data between No. 10 and No. 40 electrodes. You can set the first electrode ID to 10 and 
the last electrode ID to 40. See the right screen shot below. The electrode coordinates are read-
only.  
 
When one reads the raw data, the apparent resistivity pseudosection should be shown in the main 
window. This tool is not recommended to extract data from a borehole data set though it may 
work fine sometimes. One must be very careful about electrode numbering scheme in a borehole 
data set and pay close attention to the electrode coordinates.  
 

      
 

7.9 Extract 1D Data  
 
This utility is used to extract a 1D sounding data set from a 2D data set so that one can process 
the sounding data in EarthImager 1D with more user interaction (see above). To start, choose the 
menu Tools | Extract 1D Data. Then click the button Read 2D Data File to load a raw data file. 
The All sounding locations are listed in a combo list box. You may extract a 1D data set at any X 
coordinate in the list. A 2D data set applicable for extraction of a 1D data set should be collected 
with the Schlumberger array, Wenner array or dipole-dipole array. 

 
7.10 Extract Resistivity Log  
 
This utility extracts resistivity data at different depths from the inverted resistivity section at a 
user-specified x coordinate. The result is similar to borehole resistivity log. To get started, go the 
menu Tools | Extract Resistivity Log and input a valid x coordinate within the inverted resistivity 
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section. Then give a file name for the extracted data. The length unit setting depends on the 
Meter/Feet setting on the main toolbar. Here is a sample extracted resistivity log file. 
 

  
 
 
 

x = 36.000(m) 
Depth(m)   Resistivity(Ohm-m) 
0.000  617.952 
0.923  401.220 
2.860  172.338 
4.991  3116.879 
7.336  10760.530 
9.915  5111.122 
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8. THEORY OF INVERSION 
 
8.1 What Is Inversion? 
 
Resistivity surveys measure injected current (I) through transmitting electrodes and potential 
difference (voltage V) between two receiving electrodes. Measured current and voltage together 
with electrode geometry (K) may be converted into apparent resistivity (ρBaB). Normalized voltage 
by current (V/I) and apparent resistivity ρBaB are data in the inversion. V/I and ρBaB data are 
equivalent quantities that can be transformed back and forth with the help of a geometric factor 
K. 
 
The goal of resistivity survey is to image a subsurface resistivity distribution which is closely 
correlated with subsurface geology. The subsurface resistivity distribution (or its reciprocal 
electrical conductivity) is the model parameter in the inversion.  
 
The model is the partial differential equation that governs the relationship between data and 
model parameters.  
 
Forward modeling is defined as the process of predicting the data on the basis of the known 
distribution of model parameter, electrode configuration and model. It is a mapping from the 
model space to the data space. Forward modeling creates synthetic data sets. Forward modeling 
is also known as forward simulation, forward problem, and forward solution. 
 
Inversion is defined as the process of determining the estimates of the model parameter on the 
basis of the data and the model. Inversion is a mapping from data space to model space, and it 
reconstructs the subsurface resistivity distribution from measured voltage and current data. 
Inversion is also known as inverse modeling, inverse simulation, and inverse problem.  
 
The resistivity data inversion proceeds as follows.  
 

1) A starting resistivity model is constructed based on either the average apparent resistivity, 
or apparent resistivity distribution, or user assumption, or a-priori knowledge of 
subsurface resistivity distribution. 

2) A virtual survey (forward modeling) is carried out for a predicted data set over the 
starting model. The initial root mean squared (RMS) error at the zero-th iteration may be 
calculated at this step. 

3) Solve a linearized inverse problem based on the current model and data misfit for a 
model update (∆m).  

4) Update the resistivity model using a formula like this:  mBi+1B = mBiB + ∆m. The model 
parameter m consists of electrical conductivity of all model blocks in the finite difference 
or finite element mesh. The symbol i is the iteration number.  

5) Run a forward modeling (virtual survey) based on the updated model for an updated 
predicted data set. 

6) Calculate a new RMS error between the predicted data and the measured data.  
7) If any of inversion stop criteria is satisfied, stop the inversion. Otherwise, repeat the Steps 

(3) to (7). 
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For a thorough understanding of inversion theory, the user is encouraged to go through the 
suggested readings at the end of this manual. 
 
8.2 Forward Modeling 
 
We are dealing with a 2.5D or 2D/3D problem here, that is, a 2D earth model but a 3D electrical 
field due to a point source. It has become a standard practice to solve 2.5D resistivity forward 
modeling problem using numerical methods by discretization of the domain of investigation.  
 
The governing 3D partial differential equation is Fourier-transformed into a 2D equation to 
reduce computing time. The forward solution can be obtained by solving the 2D partial 
differential equation in the Fourier transform domain: 
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where V is the scalar electrical potential in the Fourier transform domain, and I is the electric 
current source. k is the wavenumber in the transform domain. σ is electrical conductivity as a 
function of (x, z). We implemented both finite difference and finite element methods.   
 
8.3 Damped Least Squares Inversion 
 
For a nonlinear inverse problem, the data vector, d, is a nonlinear function of the model 
parameter vector, m, that is, d = g(m). The objective of least squares inversion is to minimize a 
weighted data misfit,  
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dBobsB is the observed data, g(m) is the calculated data. WBdB is a data weighting matrix. The 
nonlinear inverse problem is solved iteratively. At each iteration, a model update vector ∆m is 
obtained by solving the following linearized system of equations.  
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)g(  is Jacobian (sensitivity) matrix. λ is a damping factor whose effect is to ensure 

that the inversion resolves primary features at the early iterations. 
 
8.4 Smooth Model Inversion 
 
The underdetermined and ill-posed nature of 2D resistivity inverse problems makes the inverse 
solution inherently nonunique. Additional constraints, or regularization, must be imposed on the 
model to single out one optimal solution. The smooth model inversion, also known as Occam’s 
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inversion, finds the smoothest possible model whose response fits the data to an a-priori Chi-
squared statistic. The true model must be at least as, but never less complex than, the smooth 
model obtained through smooth model inversion. Smooth model inversion is based on the 
assumption of Gaussian distribution of data errors. The objective function of smooth model 
inversion is given by 
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α is a Lagrange multiplier and a stabilizing factor. It determines the amount of model roughness 
imposed on the model during the inversion. R is a roughness operator. 
 
8.5 Robust Inversion 
 
Both least squares inversion and smooth model inversion are based on a L2-norm criterion. 
Robust inversion is based on the assumption of exponential distribution of data errors and 
minimizes an L1-norm of combined data misfit and model stabilizing functional.  
 
8.6 Inversion of IP Data 
 
There are two approaches for IP data inversion. First, a linear IP inversion is carried out 
immediately after resistivity inversion with an assumption of small chargeability. Linear 
inversion is done in one iteration. Second, nonlinear IP and resistivity inversion proceeds in an 
alternative manner. This method can deal with any kind of IP data sets and will produce more 
accurate IP images, but with a longer runtime.  
 
8.7 Time Lapse Inversion 
 
In-situ monitoring of subsurface processes using the resistivity method has become a proven 
technology. The goal of in-situ monitoring is to investigate the changes in the ground. These 
changes may be resulted from moisture changes, temperature changes, salinity changes, 
contaminant migration, to name a few. In a monitoring application, resistivity data are usually 
collected at the same location but at the different times. The resistivity data collected at the 
beginning of monitoring is the background data. The background data is inverted using a 
standard inversion method to reconstruct the background resistivity model, i.e., the subsurface 
resistivity distribution. The subsequent data sets are inverted using the time lapse inversion 
method. A percent difference of resistivity is defined as the ratio of the difference of the 
subsequent resistivity value and the background resistivity value to the background resistivity 
value. A percent difference of conductivity may be calculated in a similar manner. These 
difference images are used to visualize the subsurface changes. 
 
The time lapse inversion method takes advantage of known background data and model and 
incorporates them into the inversion of subsequent data sets. There are several advantages by 
doing this. First, inversion artifacts may be canceled in the difference images. Second, a faster 
convergence is expected due to a good starting model. Third, small changes may be detectable. 
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9. HELP 
 
9.1 Instruction Manual in PDF 
 
This menu item brings up a PDF help file in Acrobat Reader.  
 
9.2 AGI Home Page 
 
This will lead to the website of Advanced Geosciences, Inc. at https://www.agiusa.com/. 
 
9.3 EarthImager User Group 
 
This is an AGI EarthImager support page with software updates for users to download. The 
website address is HTUhttps://www.agiusa.com/files/eicust/earthimageruser.shtmlUTH. Refer to the 
Section 1.2 for more detail. 
 
9.4 Upgrade 
 
The menu item Help | Upgrade brings up a dialog box for user to enter an upgrade license code. 
An EarthImager upgrade means to add one or more special-purpose software modules to 
EarthImager and AGI charges an upgrade fee to add a new module. Refer to the Section 2.4 for 
more detail. The license code below is invalid and it is for illustration only. 
 

  
 
9.5 About EarthImager 2D 
 
This will display a message box showing program name and copyright information. The AGI 
logo is also a link to the AGI website. 
 
9.6 EarthImager 2D Release Notes 
 
This menu item under the Help menu brings up the EarthImager 2D release notes to the default 
internet browser. 
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10. MULTILINGUAL SUPPORT 

 
10.1 Introduction 
 
We added multilingual support to our data processing software such as AGI SuperSting 
Administrator, EarthImager 2D and EarthImager 3D. Now you can translate EarthImager GUI 
into your own language by yourself. To add support for a new language, all you need to do is to 
translate the language file ENGLISH.LNG into your language. 
 

 
 

 
 
A “Language” menu was added on the main menu of EarthImager. Supported languages are 
listed under the language menu. In the figure above, both English and 6 others are supported. 
More languages will be added soon. The language files are installed, by default, in the folder: 
C:\Programs\AGI\EarthImager2D\lang. All supported languages would have a language file 
listed in this folder.  
 
To display EarthImager user interface in a different language, one needs either a local-language 
version of Windows or appropriate setups for the local language. These settings are located in 
Control Panels | Regional and Language Options. The two screen shots below show the English-
version Windows setups for display of the EarthImager user interface in Chinese. 
NOTE: All European languages using the Latin alphabet are displayed properly without having 
to modify this setting. 
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10.2 Add Your Language to EarthImager 
 
To turn EarthImager GUI in your language, simply make a copy of ENGLISH.LNG as 
MYLANGUAGE.LNG, for example, FRENCH.LNG, and translate the key words in the new 
language file into your language. Your language will be automatically added to EarthImager 
without any change inside EarthImager. Please do not delete or modify the English language 
file ENGLISH.LNG. Here are first few lines of ENGLISH.LNG: 
 
1 [Info] 
2 Language=English  
3 
4 [Font] 
5 Name=MS Sans Serif  
6 Charset=1 
7 
8 [TfrmMain] 
9 Caption="AGI EarthImager 2D" 
10 tbSettings.Caption="Settings Window" 
11 tbSettings.Hint="Settings Window" 
12 ToolButton4.Caption="ToolButton4" 
13 ToolButton1.Caption="ToolButton1" 
14 tbColorContour.Caption="Color and Contour Properties" 
15 tbColorContour.Hint="Color and Contour Properties" 

 
The line numbers from 1 to 15 are not part of the language file and they are added for illustration 
purpose only. On the second line Language=English, change the word “English” into your 
language name. This name will be the menu item name under the Language menu. On Line 5, 
choose a font name of your native language. Finally, translate all quoted text on the right hand 
side of “=” sign from Line 9. That is, you should translate "AGI EarthImager 2D", "Settings 
Window", etc. into your own language. The double quotation signs must be kept and your 
translation should be kept inside the double quotation. The ending quote is important to include! 
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Here is a sample translated Chinese language file (CHINESE.LNG): 
 
[Info] 
Language=中文Chinese 
 
[Font] 
Name=MS SONG  
Charset=1 
 
[TfrmMain] 
Caption="AGI 二维地质成像软件" 
tbSettings.Caption="反演参数窗口" 
tbSettings.Hint="反演参数窗口" 
ToolButton4.Caption="ToolButton4" 
ToolButton1.Caption="ToolButton1" 
tbColorContour.Caption="颜色和等值线参数" 
tbColorContour.Hint="颜色和等值线参数" 
 
Once you complete the translation of English language file into your language, please email us a 
copy of your new language file (support@agiusa.com). If you find any inappropriate translation 
in any language file, please inform us or email us the corrected language file. 
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